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LTspice segédlet

1. Bevezető

Az LTspice az elektronikai iparágban az egyik legelterjedtebb1 SPICE (Simulation Program with Inte-
grated Circuit Emphasis) alapú, analóg áramkörök szimulálására szolgáló szoftver. A SPICE programcsalád
fejlesztése az 1970-es években kezdődött a Berkeley egyetemen a SPICE1 programmal, de igazi sikereket a
SPICE2 1975-s debütálása hozta. Ennek következtében a SPICE betűszó elválaszthatatlanul összeforrt az
áramkör-szimulátorok világával. Jelenleg a szabványosított, ipari áramkörtervezési módszertanok szerves részét
képezi a tervezett áramkör viselkedésének szimulálása SPICE-alapú szoftverek segítségével.

A SPICE programok elterjedését további változatok is segítették, melyek mind a mai napig megtalálhatók
a piacon. Ilyen programok pl. a PSPICE (jelenleg a CADENCE birtokolja), a HSPICE, a TINA (Toolkit for
Interactive Network Analysis), amit a budapesti DesignSoft cég készített el 1990-ben, valamint az LTspice is.
Ezen szimulátoroknak közös tulajdonsága, hogy az áramköri leírást egy ún. NETLIST, vagy magyarul netlista
fájl tartalmazza. Ebben a fájlban szövegesen és szabványosított formátumban találhatók meg az áramköri kom-
ponensek, azok paraméterei, az áramköri összeköttetések leírása (az alkatrész melyik lába melyik csomóponthoz
kapcsolódik), valamint az esetleges egyéb kulcsszavak és szimulációs direktívák. Ezeket a netlista állományokat
beolvasva végzik el a szimulációs motorok a szimulációkat. A könnyebb kezelhetőség érdekében a modernebb
szoftverek egy grafikus kezelőfelülettel fedik el a szöveges fáljokat és a háttérben futó szimulációs motorokat.

Az LTspice nevét a Linear Technology cégről kapta, mely eredetileg hozta a piacra 1999-ben. A cég a
szoftvert ingyenesen (freeware-ként) és korlátozások nélkül2 dobta piacra, mely nagyban elősegítette az LTspice
elterjedését. 2017-ben a céget felvásárolta az Analog Devices közel 15 milliárd amerikai dollárért, azonban az
akvizíciót követően sem változott a szoftver freeware jellege! A szoftver hosszabb fejlesztési ciklussal rendelkezik,
így nem ritka, hogy a kiadott verziók között akár 5-10 év is eltelhet. Ennek következtében valószínűsíthető,
hogy a jelenlegi XXIV változat és a hozzá íródott segédlet is aktuális marad.

A legfrissebb elérhető változat az alapszoftveren felül számos beépített modellfájlal érkezik az Analog De-
vices, a Linear Technology és a Maxim Integrated cégek áramköri kínálatából. Ezen felül számos edukatív
áramköri és szimulációs példa is található az alap installáció mellett, melyek remekül demonstrálják a szoft-
verben rejlő lehetőségeket. Ennek megfelelően buzdítjuk az olvasót az egyes funkciók mélyeb megértésére és a
hozzájuk kapcsolódó tesztáramkörök kipróbálására!

Manapság az LTspice-t előszeretettel alkalmazzák a nagyfrekvenciás elektronika, a kapcsolóüzemű tápegy-
ségek, az audiótechnika és a teljesítményelektronika területein. A széleskörű elterjedésének és a szimulátorban
rejlő lehetőségek miatt életszerűnek tartjuk a szoftver használatát és ennek megfelelően íródott ez a segédlet,
mellyel reméljük a szoftver használata könnyebbé és érthetőbbé válik majd! Fontos megjegyezni, hogy ezen se-
gédlet, ugyan törekszik a részletességre, de nem kíván az LTspice teljeskörű magyar nyelvű dokumentációjaként
szolgálni. Ebben a dokumentumban részletezett információkon felül javasoljuk az olvasónak az LTspice angol
nyelvű súgójának használatát (F1 gyorsgomb), valamint a hivatalos súgóban nem dokumentált funkciókhoz
a szintén angol nyelvű wikipedia oldalt, mint referencia. Meg kell ugyanakkor jegyezni, hogy ezen dokumentá-
ciók kissé szűkszavúan fogalmaznak, valamint a komponensek és funkciók használatát elsősorban a netlistában
szereplő formátumban közlik, így a kezdő felhasználók számára nehezebben értelmezhetőek! Ezen hiányosságok
miatt is ajánljuk jelen segédlet használatát!

2. LTspice telepítése

Az LTspice telepítéséhez látogassunk el az Analog Devices honlapjára és töltsük le az operációs rendszerünknek
megfelelő változatot! A jelenleg támogatott operációs rendszerek a Windows 10-es 64bit-es és ennél frissebb
operációs rendszerek, valamint az OSX 10.15-ös és frissebb változatai.

1Mike Engelhardt gondolatai
2Számos szoftver esetében az ingyenes változat csak limitált módon működik. Például korlátozzák a szimulálható

csomópontok számát, vagy korlátozzák a felhasználható erőforrások mennyiségét. Nincs ez így az LTspice esetében, ahol
a szoftvernek csakis korlátozások nélküli és ingyenes változata létezik!
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Linux rendszerre történő telepítéshez szükséges egy Windows emulátor. Ennek a folyamatát részletesen
taglaljuk a későbbiekben.

2.1. Windows és OSX

Windowsra történő telepítéshez csak a letöltött msi fájlt kell futtatni és beállítani a telepítési állományok
elérési útját, ami alapértelmezetten a C:\Program Files\ADI\LTspice mappa, ha a szoftvert a számító-
gépünk összes felhasználójának telepítjük. Abban az esetben, ha csak az aktuális felhasználónk számára sze-
retnénk telepíteni, úgy az alapértelmezett telepítési út a C:\users\USERNAME\AppData\Local\Prog-
rams\ADI\LTspice mappa lesz. Figyelem az elérési útban szereplő USERNAME almappa lecserélendő
az aktuális felhasználó felhasználónevére! Ebben a segédletben a továbbiakban az előbbi módon telepített
változatra közöljük az elérési utakat. Ettől eltérő esetben az elérési utakat módosítani kell!

A telepítés utáni első futtatáskor az LTspice jelezheti, hogy az alkatrészkönyvtár régóta nem volt frissítve és
lehetőséget biztosít ennek megoldására. Ha a frissítés mellett döntünk egy rövidebb-hosszabb telepítési folyamat
indul meg, mely során a hivatalos online forrásokból a program letölti a szükséges modellfájlokat és integrálja
azokat a telepített példány könyvtáraiba.

OSX operációs rendszer esetén a folyamat hasonlóan követhető le, azonban az alapértelmezett elérési út
más lesz.

2.2. Linux

Linux rendszer esetében is lehetőségünk van az LTspice futtatására egy Windows kompatibilitási réteg telepíté-
sével. Ebben a dokumentumban az egyik legelterjedtebb programot a wine-t fogjuk használni. Linux esetében
a csomagkezelő disztribúciónként változik, így itt csak Ubuntu operációs rendszerhez és az apt-get csomagke-
zelőhöz tartozó esetet részletezzük. A telepítéshez ajánlott a Wine legfrissebb változatát telepíteni, azonban
az nem található meg az Ubuntu linux repozitóriumában, így azt nekünk kell hozzáadni. Ehhez futtassuk le a
következő parancsokat a terminálból, ahogy az a Wine hivatalos oldalán szerepel:

user@computer:~$ sudo dpkg --add-architecture i386
user@computer:~$ sudo mkdir -pm755 /etc/apt/keyrings
user@computer:~$ sudo wget -O /etc/apt/keyrings/winehq-archive.key https...

A parancsok segítségével engedélyezzük a csomagkezelőnk számára az i386-os, azaz a 32-bites alkalmazások
telepítését. Windows-os applikációk esetén sok program még mindig használ 32-bites könyvtárakat, így szüksé-
ges ezek engedélyezése, különben az LTspice nem fog futni. Az utolsó két parancs hozzáadja a szükséges digitális
aláírási kulcsokat a kulcskarikánkhoz.

Ezután adjuk hozzá a disztribúciónknak megfelelő forrásfájl állományt a forrásfájlok listájához. Esetünkben
az Ubuntu 22.04.4-es LTS változatához megfelelően a Jammy Jellyfish forrásállományt kell kiválasztanunk.

user@computer:~$ sudo wget -NP /etc/apt/sources.list.d/ https...

Frissítsük ezután a lokális repozitóriumaink listáját, és telepítsük a legfrissebb Wine stabil verzióját:

user@computer:~$ sudo apt-get update
user@computer:~$ sudo apt-get upgrade
user@computer:~$ sudo apt-get install --install-recommends winehq-stable
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A wine telepítése után le kell töltenünk a Windows-os telepítő msi fájlt az Analog Devices honlapjáról.
Ezután a terminál ablakban el kell navigálnunk a letöltött fájlt tartalmazó mappába és el kell indítsuk a
telepítést wine-t használva.

user@computer:~$ cd Downloads
user@computer:~/Downloads$ wine msiexec /i LTspice64.msi

Ezután a Windows-os esethez hasonlóan kell folytatni a telepítést. Mivel egy virtualizációs rétegen keresztül
telepítettük az LTspice-t, így a programindító exe fájl a következő mappában található:

~/.wine/drive_c/Program\ Files/ADI/LTspice
Linux alatt az exe fájlok nem futtathatóak, azonban a wine-t felhasználva elindíthatjuk őket egy kompati-

bilitási rétegen keresztül. Ehhez a következő parancsot kell futtassuk:

wine ~/.wine/drive_c/Program\ Files/ADI/LTspice/LTspice.exe

A parancs futtatását megkönnyítendő létrehozhatunk egy alias-t, mellyel egy könnyebben megjegyezhető
kulcsszóval tudjuk elindítani az LTspice-t. Ehhez nyissuk meg a .bash_aliases fájlt kedvenc szövegszerkesz-
tőnkkel.

user@computer:~/Downloads$ nano ~/.bash_aliases

Ebbe a file-ba illesszük be a következő sort, hogy hozzáadjunk egy alias-t a shell környezetünkhöz:
alias ltspice=’wine /.wine/drive_c/Program\ Files/ADI/LTspice/LTspice.exe&’
A fájl mentését követően már csak be kell töltenünk a shell környezetbe annak tartalmát:

user@computer:~/Downloads$ source ~/.bash_aliases

Ezután az LTspice az ltspice paranccsal futtathatóvá válik a terminál felületünkből. Az első futtatás
alkalmával itt is érdemes frissíteni a modellfájlokat, ahogy a program azt fel is ajánlhatja nekünk.

A fent leírt telepítési folyamatot helyettesíthetjük a PDF-hez csatolt3 UbuntuInstall.sh script fájl futta-
tásával majd a fenti source parancs hívásával.

Sajnálatos módon a Wine alapértelmezett témája megrekedt a Windows 95 világában, így a szemnek ké-
nyelmesebb használathoz javasoljuk annak átállítását. Ehhez keressünk egy szimpatikus témát ezen az oldalon.
Az új téma alkalmazásához futtatnunk kell a wine konfigurációs parancsát:

user@computer:~/Downloads$ winecfg

Ezután a Desktop Integration fül alatt kattintsunk az Install theme... parancsra és válasszuk ki a letöltött
témánkhoz tartozó .msstyle fájlt (A szerzők a gelxp2.msstyle használatát javasolják). Telepítés után a The-
me legördülő menüből ki is tudjuk választani a frissen telepített témánkat, és témától függően még további
beállításokat is tehetünk.

3A PDF 1.3-as verziójától kezdve lehetőség nyílik tetszőleges fájl PDF dokumentumhoz csatolására. Ehhez a PDF
dokumentumot egy PDF 1.3-as verziót beolvasni képes programmal kell megnyissuk. Ilyen program pl. Adobe Acrobat
vagy az Okular.
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3. Áramkörök összeállítása

Az LTspice-t elindítva egy egyszerű és modern kezelőfelület tárul elénk. Ez a modern kezelőfelület az LTspice
legutóbbi (XXIV) változatával frissült meg. Előző verziók esetében a kezelőfelület kinézete a Windows 95 kiné-
zetét tükrözte, valamint az alapértelmezett gyorsgombok is ezt tükrözték. A tradicionális LTspice gyorsgombok
nagyrészt az F1-9 billentyűket használják. Az új változatban a program futása előtt felkínálja nekünk a vá-
lasztási lehetőséget a modern és a tradicionális gyorsgombok használatához. Természetesen van lehetőségünk a
gyorsgombok megváltoztatására a (Tools > Settings > Schematic > Keyboard shortcuts) felületen
keresztül. Az egyszerűbb beállítás érdekében ehhez a pdf-hez csatolva megtalálható egy shortcuts.txt fájl,
amely egyszerűen importálható az LTspice-ba.

3.1. Sémaszerkesztő használata

Áramkörök szimulálásához először meg kell rajzolnunk őket, ehhez pedig egy új sémát kell nyitnunk (File >
New schematic) vagy a Ctrl+N gyorsgomb megnyomásával. A megnyíló szürke felületen tudunk áramköri
komponenseket lehelyezni és áramköri összeköttetéseket készíteni, valamint a komponensek paramétereit beállí-
tani. A fontosabb gyorsgombok listáját az A. függelék tartalmazza. Első példaként nézzük az 1. ábrán látható
feszültségosztó kapcsolást.

1. ábra. Egy példakapcsolás áramköri rajza 2. ábra. Szimulációs eredmények

Áramkörök megrajzolásához célszerű először a szükséges komponenseket lehelyezni. Ehhez a (Edit >
Component) menüpontot vagy a P gyorsgombot használhatjuk. A kiválasztott alkatrészt a CTRL+R
gyorsgomb segítségével forgathatjuk lehelyezés előtt, valamint a CTRL+E gyorsgombbal tükrözhetjük. Az al-
katrészek elhelyezése után célszerű beállítani az alkatrészparamétereket. Ehhez az áramköri komponensekre jobb
egérgombbal kattintva egy felugró ablakban meg tudjuk adni a szükséges paramétereket (pl. feszültségforrás
feszültségét és az ellenállások értékét stb.). Az LTspice felismeri az SI prefixumokat valamint az egyszerűsített
jelölést is. Ennek megfelelően egy 3300 Ω-s ellenállásértéket megadhatunk 3.3k és 3k3 módon is. Egyetlen
fontos megjegyzés, hogy a prefixumokat kis- és nagybetűre érzéketlenül kezeli a szoftver, így a mega és a milli
prefixumok megkülönböztetése végett a mega prefixumot meg rövidítéssel kell megadni!

Ezt a lépést követően az összeköttetéseket célszerű kialakítani. Ehhez egyszerű és könnyen átlátható séma
esetén a wire eszközt célszerű használni (Edit > Draw Wire) avagy W gyorsgomb. A vezetékezést alap-
értelmezetten 90◦-s kanyarok alkalmazásával hozhatjuk létre. Ha ettől szeretnénk eltérni, úgy a vezetékszakasz
lerakása közben a CTRL gombot lenyomva tetszőleges meredekségű vezeték húzható. Vezetékszakaszok között
jobb egérgombot nyomva megszakíthatjuk a vezetékezés folyamatát, de még mindig a vezetékszerkesztő eszköz
marad aktív.

Összetettebb vezetékezés esetén célszerű lehet az összeköttetéseket csupán a vezetékek címkézésével kiala-
kítani. Ehhez a (Edit > Label Net) opciót vagy a N gyorsgombot kell kiválasszuk. Ekkor a felugró
szövegdobozba beírva a vezeték nevét és azt hozzáillesztve a sémán lévő egyik vezetékdarabhoz vagy áramköri
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pólushoz létrehozhatunk elektromos kapcsolatokat. Ezzel a módszerrel átláthatóbb és könnyebben olvasha-
tó lesz a séma. A módszer másik előnye, hogy az így elnevezett vezetékek és csomópontok a hullámformák
megjelenítése során is az általunk megadott nevekkel lesznek beazonosíthatók.

A sémán történő navigáláshoz ki kell lépnünk az aktuális szerkesztőeszközből (pl. vezetékezése esetén a
vezetékező eszköz), ehhez az ESC gombot kell megnyomnunk. Ekkor lehetőségünk nyílik a séma fókuszban
lévő részének mozgatására a bal egérgomb lenyomásával történő egérmozdulatok segítségével. Ha szeretnénk a
séma egy távolabbi részére navigálni, akkor célszerű lehet a teljes sémát a fókuszba hozni a SPACE billentyű
lenyomásával majd az ezt követően a fókusz nagyításával az egérgörgő segítségével.

Az áramkör megrajzolása után el kell döntenünk, hogy milyen szimulációval szeretnénk vizsgálni a kap-
csolást. Ennek megfelelően el kell helyeznünk egy szimulációs direktívát a kapcsolási rajzon (Simulate >
Configure Analysis) , vagy az . billentyű lenyomásával direkt is be tudjuk gépelni a szükséges parancsokat.
A szimulációs parancsokról bővebben is értekezünk a 4. fejezetben. Ha megrajzoljuk az 1. ábra kapcsolását
és meghatározzuk a kapcsolás munkapontját, vagyis azokat a csomóponti feszültségeket és ágáramokat melyek
mellett a hálózati egyenletek teljesülnek, úgy a 2. ábra eredményeit kapjuk. Látható, hogy a kimeneti csomó-
pont feszültsége 0,5 V és az ellenállásokon, valamint a forráson 5 mA áram folyik, ahogy azt el is várjuk egy
11kΩ-s és 1kΩ-s ellenállásból álló feszültségosztó esetén.

A következőkben az egyes áramköri komponensek részletesebb bemutatásával és a paramétereinek értelme-
zésével fogunk foglalkozni.

3.2. Független feszültség- és áramforrás (V és I források)

Az egyik leggyakrabban használt áramköri elemek a független feszültség- és áramforrások, melyek LTspice-beli
áramköri jele a 3. ábrán látható. Feszültségforrást ”voltage”, míg áramforrást ”current” nevek alatt fogjuk
megtalálni az (Edit > Component) vagy P gyorsgomb lenyomásával.

3. ábra. Független feszültség- és áramforrás áramköri jele

A forrásokra jobb egérgombbal kattintva be tudjuk állítani paramétereiket. Feszültségforrás esetében egy
állandó feszültséget és egy soros ellenállást tudunk megadni, ezáltal egy Thevenin forrást tudunk modellezni.
Áramforrások esetében alapértelmezetten csak az állandó áramértéket tudjuk beállítani. Fontos megjegyezni,
hogy az LTspice használata során soha sem kell mértékegységet megadnunk, a paraméterek a megfelelő
mértékegységben vannak értelmezve. Azonban azt is fontos megjegyezni, hogy az LTspice ismeri az SI prefixu-
mokat4, így ha szeretnénk egy 100 mV-os és 1 kΩ-s belső ellenállassal rendelkező feszültségforrást létrehozni,
úgy a 100m-es és 1k-s értékeket kell begépeljük a megfelelő helyekre (DC value és Series resistance mezőkbe).

Ezeket a forrásokat felhasználva elő tudunk állítani összetettebb jeleket is, ha a források beállítási lehe-
tőségeinél az Advanced opcióra kattintunk. Mivel a két forrás nagyon hasonló, így csak a feszültségforrást
mutatjuk be részletesebben, az áramforrás esetén analóg módon értelmezettek a paraméterek.

4Ez alól csak a M kivétel, hiszen a program a netlistákat kis- és nagybetűre érzéketlenül olvassa be. Annak érdekében,
hogy a Mega prefixum is értelmezve legyen, az LTspice a meg rövidítést használja.
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4. ábra. Független feszültségforrás kibővített paraméterlistája

A forrás paraméterei között a jobb fölső sarokban az állandósult értéket tudjuk beállítani (DC value), alatta
a kisjelű paramétereket tudjuk megadni, melyek az AC szimuláció során lesznek felhasználva. Lásd később a 4.
fejezetben. A kisjelű paraméterek alatt a forrás parazitáit tudjuk beállítani. Feszültségforrás esetében soros
ellenállást és párhuzamos kapacitást tudunk modellezni.

A paraméterek között bal oldalon lévő opciókkal időben változó forrásokat tudunk definiálni. Ezekből az
opciókból leggyakrabban a PULSE, SINE és PWL opciókat használjuk, így ebben a dokumentumban csak
ezeket mutatjuk be.

Pulse opciót választva egy általánosított négyszögjelet tudunk létrehozni. Az általánosítás a véges fel- és
lefutási időkből ered, melynek következtében a jelalak trapéz jellegű lesz. Az egyes paraméterek értelmezése
az 5. ábrán látható. Az egyes paraméterek magyarázatai: Vinitial→ kezdeti feszültségszint,Von→ bekapcsolt
állapot feszültségszintje, Tdelay → időkésleltetés a bekapcsolásig, Trise → felfutási idő, Tfall → lefutási idő,
Ton → bekapcsolt állapotban lévő idő, Tperiod → periódusidő és Ncycles → impulzusok száma. Ha a
paramétereknek nem adunk értéket akkor azok figyelmen kívül lesznek hagyva a szimulációkból.

Sine forrás esetében egy általános szinuszhullámot tudunk megadni. a 6. ábrán egy példa hullámot láthatunk
a paraméterek egy adott értékeire. Az egyes paraméterek magyarázatai: DC offset → a jel DC középértéke,
Amplitude → a jel amplitúdója, Freq → a jel frekvenciája, Theta → a jel csillapítási tényezője, Phi → a
jel kezdőfázisa. A Tdelay és Ncycles paraméterek a Pulse forrásnál tárgyaltakkal azonosak. a 6. ábrán egy 2
V középértékű és 1 V amplitúdóval rendelkező csillapodó szinuszjelet jelenítettünk meg. Mivel a jel késleltetve
van, így a jel belépése előtt a kezdeti értékét veszi fel. Az ábrán jól megfigyelhető, hogy a jel már az első
periódusában sem veszi fel a 3 V-os értékét (2 V-os középérték plusz 1 V-os amplitúdó), ez a jelenség a jelentős
csillapítási faktornak tudható be.

PWL forrás esetében lehetőségünk van a feszültség időfüggvényét tetszőleges időpontokban megadni. A nem
definiált időpillanatokban a feszültségforrás szomszédos időpillanatai közötti lineáris interpolációval közelített
értékeit kapjuk. Innen ered a forrás neve is, hiszen a PWL az angol piecewise linear, azaz szakaszonként lineáris,
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5. ábra. PULSE forrás jelalakja

6. ábra. SINE forrás jelalakja

szóösszetétel rövidítéséből származik. Ezzel a módszerrel tetszőleges számú időpillanatban leírható tetszőleges
bonyolultságú bemeneti jel, csak meg kell adnunk az egyes időpillanatokban felvett feszültségértékeket. A 7.
ábrán egy ilyen jelforrásból kijövő példát láthatunk. Komplex és sok mintából álló jel esetében lehetőségünk van
egy .wav kiterjesztésű fájlt is megadni, mint jelforrás. Ebben az esetben a PWL FILE opciót kell kiválasztanunk.

3.3. Vezérelt feszültség- és áramforrások (E,F,G és H források)

Elektronikai modellezés során sokszor előfordul, hogy egy áram- vagy feszültségjel konstansszorosát szeretnénk
előállítani vagy feszültségek különbségét szeretnénk képezni. Ezeket a funkciókat ún. vezérelt forrásokkal
tudjuk megvalósítani. Az LTspice-on belül 4 db ilyen forrás található meg, plusz 2 db tetszőleges viselkedésű
forrás, melyekről a következő szakaszban foglalkozunk bővebben. Ezeket az áramköri komponenseket (ahogy
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7. ábra. PWL forrás jelalakja

a többi komponens esetén is) a prefixük különbözteti meg. Ennek megfelelően az LTspice-ban megtalálható
komponenseket az angol ÁBC betűivel szokás jelölni. Ez a feszültségforrások esetén V, ellenállás esetén R és
vezérelt források esetén a kimaradó betűket felhasználva az E, F, G és H prefix jutott. A források működésének
megértése érdekében figyeljük meg a 8. ábra kapcsolását és vegyük végig a különböző források által elvégzett
műveleteket.

8. ábra. Vezérelt forrásokat felhasználó kapcsolás

A kapcsolás bemenetén a V1 forrás beállítja a node1 csomópont potenciálját 1 V-ra, ezt követően az E1
forrás képezi a node1 és gnd csomópontok közötti potenciálkülönbség kétszeresét és ezt a node2 és gnd
csomópontok közé kényszeríti. Ezen feszültség hatására az 1 Ω-s R1 ellenálláson 2 A áram kezd el folyni, amit
az E1 forrás biztosít. G1 forrás a node2 és gnd közötti feszültség ötszörösét (5 Siemens-szeresét), azaz 10 A-t
átkényszerít a 0.1 Ω-s R2 ellenálláson, ezáltal 1 V feszültségesést produkálva rajta.

F és H források vezérlőjele egy megadott feszültségforrás árama tud csak lenni, így F1 forrás a V1 forráson
átfolyó áram, kapcsolásunkban 0 A, 5 Siemens-szeresét folyatja át H1 forráson. H1 forrás pedig az E1 forrás
áramának, -2 A kapcsolásunkban, a 2 Ohm-szorosát állítja elő node4 csomóponton tehát -4 V-t.
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A feszültségforrások áramai a villamosságtani szimmetrikus referenciairányok szerint vannak meghatározva,
tehát a forrás (és minden kétpólus) árama a feszültségének referenciairányával azonos (+ ból mutat a - ba).
Ennek köszönhető, hogy E1 forrás áram -2 A.

A feszültséggel vezérelt források (E és G) esetében E2 és G2 néven rendelkezésre áll a vezérlőjel fordított
polaritású szimbóluma is. Egyes esetekben kényelmesebb lehet ennek a használata, így érdemes említést tenni
róla. Szimulációs szempontból nincsen különbség a források között, hiszen csak a csomópontok sorrendje lesz
felcserélve a netlista fájlban.

3.4. Tetszőleges viselkedésű források (BV és BI források)

Az előző szakaszban szereplő források közös jellemzője, hogy a kimeneti mennyiségük (feszültség- vagy áramjel)
csak a vezérlőmennyiség konstansszorosával tud arányos lenni. Egyes esetekben szükségünk lehet összetettebb
viselkedésű komponens szimulációjára. Ebben az esetben tudjuk használni az ún. tetszőleges viselkedésű, vagy
másnéven B forrásokat (az angol arbitary Behavioral sources rövidítésből). A tetszőleges viselkedés jelző a forrá-
sok által szolgáltatott viselkedési leírások széles tárházára utal. A források kimeneti jelét különböző matematikai
és logikai függvényekkel és azok kompozícióival tudjuk leírni. Ezt a leírási módot a továbbiakban vezérlési egyen-
letnek fogjuk hívni. A teljesség igénye nélkül5 lehetőségünk van a hatvány, trigonometriai, hiperbolikus, idő
szerinti integrálás és deriválás függvényeket, lineáris interpoláció és logikai alapműveletek kombinációjával az
általunk kívánt viselkedést leírni. Természetesen a vezérlési egyenletben használhatjuk a hálózat villamos jeleit
is a V(A,B) és Ix() kifejezésekkel a vezérlési egyenletekben.

9. ábra. Vezérelt források használata

A források működésének illusztrációja végett figyeljük meg a 9. ábrát. Az ábrán a B1 forrás árama és a B2
forrás feszültsége az 1. egyenletek alapján függenek a node1 csomópont feszültségétől.

5A források által biztosított matematikai formulák listájához látogassunk el a súgó F1\LTspice\Circuit elements\B.
Arbitrary Behavioral Voltage or Current Sources fülre.
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IB1(U) =

10
[
mA
V 2

]
U2, ha U ≥ 0

0, máskülönben

VB2(U) = sin

(
6π

[
1

V

]
U

) (1)

A forrásokat felhasználva megvalósíthatunk aktív és passzív kétpólusokat is, valamint tetszőlegesen bonyo-
lult vezérlőjelek is előállíthatók, azonban ügyelni kell a források jeleinek folytonosságára is. Nem folytonos és
nem folytonos deriváltakkal rendelkező jelek esetén nehézkes lehet a megoldó motornak konvergens megoldást
találnia, így tranziens szimuláció (lásd 4. fejezetet.) esetén pl. nagyon kicsi időlépést kényszerül használni, ezzel
megnövelve a szimulációhoz szükséges számítási időt!

3.5. Hierarchikus áramköri blokkok

Az eddig említett áramköri elemek rengeteg lehetőséget biztosítanak számunkra áramköri komponensek és kap-
csolások modellezésére, azonban előfordul, hogy a kapcsolás mérete vagy összetettsége miatt kedvezőbb lenne
az áramköri alkomponenseket hierarchikusan rendszerezni. Hierarchikus rendezés alatt az áramköri kompo-
nensek funkció szerinti csoportosítását értjük, pl. egy audió erősítőben megtalálható egy előerősítő kapcsolás,
egy teljesítmény erősítő és egy tápegység, csak hogy néhányat említsünk az áramköri blokkokból. Ezeket a
komponenseket célszerű külön sémákon megrajzolni és az elsődleges sémán (top level schematic) csak egy
szimbólummal hivatkozni rájuk. Ez a metodika elősegíti az áramköri komponensek rendszerezését, funkcionális
dekompozícióját, áramköri komponensek újrafelhasználhatóságát és a séma könnyebb átláthatóságát. Egy ilyen
hierarchikus sémára mutatunk példát a 10. ábrán.

10. ábra. Előerősítő hierarchikus tesztkapcsolása

Hierarchikus blokkok készítése során meg kell rajzolnunk a blokk sémáját és ki- és bemeneti kapcsolódási
pontokat (ún. pineket) kell elhelyeznünk rajta. Ezek a kapcsolódási pontok gyakorlatilag a csomópontok
és vezetékek címkéit jelentik, amelyek a blokk elektromos összeköttetéséért felelősek. A címkék esetében ha
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kiválasztjuk a pólusok (portok) típusát (input, output vagy bidirectional), akkor az egyszerű szöveges megje-
lenítés helyett egy keretezett szövegdobozt fogunk látni, a pólus típusának megfelelően (bemeneti, kimeneti és
kétirányú). Erre láthatunk példát a 11. ábrán.

11. ábra. Előerősítő kapcsolási rajza 12. ábra. Előerősítő szimbóluma

A kapcsolási rajz megrajzolása után egy jelképes szimbólum ábrát kell készíteni, amely majd a hierarchikus
blokkot fogja reprezentálni a magasabb rendű kapcsolási rajzokon. Célszerű a blokk szimbólumának megrajzo-
lásánál a blokk funkcióját is feltüntetni, legalább jelképesen és egyszerűsítve, ezzel megkönnyítve a magasabb
rendű séma olvashatóságát, valamint elkerülve a semmitmondó téglalapokkal telirakott sémákat. Új szimbólum
készítéséhez (File > New symbol) menüponot kell válasszuk, ekkor megnyílik az szimbólumszerkesztő, mely
nagyon hasonlít a sémaszerkesztőhöz, azonban itt leginkább grafikai primitíveket (egyenes, téglalap, ellipszis és
körív) tudunk felhasználni a szimbólum elkészítéséhez. Ezeket a grafikai primitíveket a (Jobb egérgomb
> Draw) menüből választhatjuk ki. A grafikai primitívek ún. horgonypontokkal vannak definiálva (anc-
hor points), melyek a primitívek utólagos szerkesztését teszik lehetővé. Ezeket a horgonypontokat piros körök
jelölik és a megjelenítésüket a (View > Anchor points) vagy az O gyorsgomb megnyomásával tudjuk
ki- és bekapcsolni. A primitívek szerkesztéséhez a Move (M) vagy Stretch (S) eszközöket tudjuk használni
melyekkel a horgonypontokat megfogva vagy kijelölve tudjuk módosítani az adott primitívet. A 12.ábrán az
illusztratív előerősítő szimbólumát láthatjuk.

A szimbólum megrajzolása után el kell helyeznünk rajta a séma pólusait, amit a (Jobb egérgomb >
Add pin) vagy P gyorsgombbal tudunk megtenni. Fontos megjegyezni, hogy a szimbólum megrajzolása
során egy sűrűbb ráccsal dolgozunk, mely lehetővé teszi a finomabb ábrák megrajzolását, azonban a pólusok
csatlakozásait csak egy ritkább rács pontjaira tudjuk elhelyezni (fekete pontok a szimbólumszerkesztő felületén).
Célszerű a szimbólum megrajzolása során figyelni ezekre, hogy a portok a szimbólum ábrájának szerves részét
képezzék! A portok neveinek megválasztása során, ha a szimbólum egy LTspice primitívet (pl. dióda) vagy
beépített áramköri könyvtári komponenst tartalmaz (pl. netlista fájlal megadva), úgy a port nevének nincs
elektromos szempontból jelentősége. Ha a szimbólum egy alacsonyabb szintű sémát reprezentál (ahogy ebben
a példában szerepel), úgy a portok neveinek egyezniük kell a reprezentált séma vezetékcímkéivel, hiszen ezen a
név eggyezésen keresztül valósulnak meg az elektromos összeköttetések. Mind a két esetben célszerű a portokat
abban a sorrendben hozzáadni a szimbólumhoz ahogy azt a netlistában szeretnénk, vagy elvárt a netlistával
megadott áramköri komponensek esetén, lásd később a 7. fejezetben.

A szimbólum elkészítése után hozzá kell adnunk az esetleges attribútumokat az elkészített szimbólumunkhoz,
ehhez a (Edit > Attributes > Edit Attributes) menüpontot kell megnyissuk. Az egyetlen attribútum
amit szerkesztenünk kell az a szimbólum típusa (symbol type). Ezt a beállítást át kell kapcsoljuk Block
állapotra, ezzel jelezve az LTspice-nak, hogy egy alacsonyabb rendű és sémával definiált áramköri blokk van
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reprezentálva ezzel a szimbólummal. Fontos megjegyezni, hogy az LTspice a szimbólum és a mögöttes séma
között az azonos fájlnéven keresztül teremt kapcsolatot (leszámítva a kiterjesztést).

A szimbólum elkészítéséhez egy alternatív mód az automatikus szimbólumgenerátor használata. Ehhez
az aláramkör sémáján a (Jobb egérgomb > Hierarcy > Open this sheet’s symbol) menüt kell
kiválasztanunk, ekkor az LTspice ha nem találja a sémához tartozó szimbólumot, úgy felajánlja az automata
generálást. Ebben az esetben egy generikus téglalapot kapunk szimbólumként, ahol a pólusok a hozzájuk
tartozó címkék típusa alapján kerülnek elhelyezésre. Egyszerűbb blokkok esetében célszerű lehet ezt a módszert
használni a szimbólum generálására és ezen a szimbólumon csak kisebb mértékű módosításokat végezni!

4. SPICE szimulációs direktívák

Az áramköri kapcsolási rajzok összeállítása, valamint a hozzájuk rendelt szimbólumok segítségével összetett
szimulációs modelleket tudunk létrehozni, azonban ezekben a szimulációs modellekhez még nem adtuk hozzá az
elvégzendő szimulációkat és azok paramétereit. Ebben a fejezetben az LTspice szimulációs képességeit ismertet-
jük röviden egyszerű szimulációk esetére. Összetett, több iterációt és egyéb utófeldolgozást kívánó szimulációk
futtatását az 5. fejezetben ismertetjük majd bővebben.

A futtatandó szimulációs analízis parancsát ún. SPICE direktívával tudjuk megadni, ezeket a direktívákat
a kapcsolási rajzra elhelyezett . utasításokkal tehetjük meg. Fontos megjegyezni, hogy szimulációs analízisből
egyidejűleg csak egyetlen példány lehet a szimulálandó sémán! Több különböző szimuláció futtatásához lét-
rehozhatunk több szimulációs direktívát, melyek közül egy kivételével mindet kommentként vagy szövegként
hozzuk létre. Ezt követően a különböző szimulációk futtatásához manuálisan kell kiválasztanunk a futtatandó
szimulációs direktívát és a többit kommenté vagy szöveggé alakítani.

Szimulációs direktívák hozzáadásához és szerkesztéséhez a (Simulate > Configure Analysis) , (A
gyorsgomb) menüt kell kiválasztanunk, ekkor egy grafikus felületen beállíthatjuk a szimulációhoz szükséges
paramétereket. Gyakorlottabb felhasználók számára a szimulációs direktívák szintaktikája ismert lehet, emiatt
kényelmesebb lehet a grafikus felületet kihagyva a direktívákat egyenesen a sémára elhelyezni. Ehhez a (Jobb
egérgomb > Draft > SPICE directive) parancsot, vagy a . gyorsgombot kell használjuk. Ekkor egy
szöveges mezőbe begépelve a szimulációs direktívát az lehelyezhetővé válik a séma felületén.

4.1. Munkapont meghatározása és a .op direktíva

Az egyik alapvető funkcionalitása az áramköri szimulációs programoknak a nemlineáris munkapont meghatáro-
zása. Ezen szimuláció során a sémán lévő összes komponens nemlineáris kisfrekvenciás karakterisztikáját és a
komponensek közötti összekapcsolási kényszereket is figyelembe véve egy - általában nemlineáris - egyenletrend-
szert állít össze és old meg a SPICE szimulációs motor. A nemlineáris algebrai egyenletrendszer megoldására
a megoldó motor a Newton-Raphson módszert használja. Az egyenletrendszer sikeres megoldásához szükséges
a szimulálandó áramköri komponensek karakterisztikájának és azok deriváltjainak folytonossága (C1 folytonos-
sági függvényosztály). Ez a folytonosság az LTspice összes beépített komponense esetén fennáll, azonban az
általunk készített kapcsolások esetében ez nem mindig garantált! Konvergenciaproblémák esetében célszerű a
problémásnak vélt áramköri komponens karakterisztikáit módosítani, hogy simábbak legyenek (C1 folytonos-
ság!).

Munkaponti szimuláció futtatásához a sémán a következő direktívát kell elhelyeznünk, majd elindítani egy
szimulációt a (Simualte > Run) paranccsal, vagy a SHIFT+R gyorsgombbal.

.op

A szimuláció lefutása után a csomóponti potenciálok és az ágáramok egy felugró ablakban lesznek listázva.
Célszerű a szimuláció futtatása előtt a számunkra releváns csomópontokat címkékkel ellátni (N), hogy a szi-
mulációs eredmények közül könnyebben beazonosíthatóak legyenek az eredmények. Alapértelmezetten csak az
elsődleges sémán lévő csomóponti potenciálok, valamint a sémán lévő eszközök áramai lesznek megjelenítve. Ha
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szeretnék a hierarchikus blokkok potenciáljait is meghatározni, úgy a (Tools > Settings > SaveDefaults)
menüpont alatt be kell kapcsoljuk a Save subcircuits nodal voltages opciót. Az aláramkörökben talál-
ható komponensek portáramainak megjelenítéséhez pedig a Save subcircuits device currents opciót kell
engedélyeznünk. Munkaponti szimulációra és annak eredményére egy példát láthatunk az 1. és a 2. ábrákon.

4.2. Forrásparaméterek változtatása és a .dc direktíva

A gyakorlatban többször előfordul, hogy az áramkörünk munkapontját több forrásfeszültség esetén is szeretnénk
meghatározni és optimalizálni valamilyen metrika alapján. Ebben az esetben lesz hasznos számunkra a DC
sweep szimuláció. A szimuláció során akár három független forrás állandósult (DC value) értékét változtathatjuk
többféle módon. Alapértelmezés szerint a források értékeit lineárisan változtatjuk, vagyis az egyes szimulációs
értékek egy számtani sort képeznek. Lineáris lépésközön kívül választhatunk oktáv, dekád vagy lista alapú
lépésközöket.

Oktáv és dekád választása esetén a forrás értékei logaritmikus skálán lesznek egyenletesen elosztva, vagyis az
értékek egy mértani sort fognak alkotni. Mind a két esetben meg kell adni a szimulációk kezdeti és végső értékét,
valamint hogy oktávonként vagy dekádonként hány szimulációt szeretnénk elvégezni. Két érték távolsága 1
oktáv, ha az értékek hányadosa kettő6, míg 1 dekád távolság esetében a hányados tíz lesz. Matematikailag a 2.
formulák adják meg az egyes szimulációs pontokat. A formulákban v0 a mértani sor kezdő értéke és n az egy
oktávban vagy dekádban lévő osztópontok száma.

oi = v0
n√
2

i

di = v0
n√
10

i (2)

A szimulációs értékek megadásának utolsó lehetősége a lista szerinti felsorolás. Ekkor egymás után kell felso-
rolnunk a szimulálandó értékeket tetszés szerinti sorrendben. A szimuláció során az értékek növekvő sorrendben
lesznek szimulálva és kiértékelve.

A DC parancs használatára egy jelképes példa egy bipoláris tranzisztor kimeneti karakterisztikáit megha-
tározó szimulációs összeállítás. A kapcsolást a 13. ábrán láthatjuk, míg a szimulált kollektorköri áramokat
a 14. ábrán figyelhetjük meg. A kapcsolás egy bázisra kötött független áramgenerátorból és a kollektorra kö-
tött független feszültségforrásból áll. A karakterisztikák meghatározásához a következő SPICE direktívát kell
elhelyezni a sémán (. gyorsgomb):

.dc V2 0 1 1m I1 list 0 25u 75u 150u 200u

Kezdő felhasználók számára ebben az esetben is ajánlott a grafikus szerkesztőfelület használata, mely a
(Simulate > Configure Analysis > DC sweep) menüből érhető el. A fenti direktíva a V2-s forrás
feszültségét 0 V és 2 V között 1 mV-os lineáris lépésekkel változtatja, valamint az I1-es forrás értékét 0 µA,
25 µA, 75 µA, 150 µA és 200 µA értékekre állítja be a lista opciót használva. A direktíva használata során
az elsődlegesen változtatott forrás értékei lesznek felhasználva a jelek ábrázolása során az X tengelyként, míg a
másodlagos és harmadlagosan változtatott forrásértékek független görbéket fognak alkotni, melyeket különböző
szinekkel annotál majd a program.

A DC sweep szimuláció alapértelmezetten csak 3 független forrás együttes változtatását teszi lehetővé,
azonban ahogy később az 5. fejezetben látni fogjuk lehetőségünk van tetszőleges számú forrás értékeit változtatni
a .step direktíva felhasználásával. Meg kell azonban jegyezni, hogy sok forrás változtatása esetén a szükséges
szimulációs idő igen gyorsan fog növekedni, hiszen minden újonnan felvett forrás esetében az összes korábbi
szimulációs lépést meg kell ismételni!

6Az oktáv alapján gondolhatnánk, hogy a nyolcas számhoz köthető az elnevezés, azonban a nyolcas szám az oktáv
eredeti zenei gyökereihez nyúlik vissza. Egy adott zenei hang és az 1 oktávval távolabbi szomszédja eléréséhez a 8.
zenei hangra kell ugorjunk, azonban az egy oktávnyira lévő hangok frekvenciában kifejezve egymás duplái. Az elnevezés
gyökere az emberi hallásra vezethető vissza. Két hangot harmonikusnak érzékelünk, ha a frekvenciáik hányadosa kicsi
értékű számlálóval és nevezővel rendelkezik pl. f1

f2
= 3

2
.
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13. ábra. Karakterisztika meghatározó kapcsolás 14. ábra. BJT kimeneti karakterisztikái

4.3. Kisjelű analízis és a .ac direktíva

Kisjelű analízis során az alapfeltevésünk, hogy a kapcsolás áramaiban és feszültségeiben történő változás ele-
gendően kis mértékű ahhoz, hogy az áramköri nemlinearitások hatása elhanyagolható legyen. Lényegében a
kapcsolást a munkapontban közelítjük annak linearizált változatával, analóg módon ahogy egy függvényt az
elsőrendű Taylor-polinomjával, azaz véges tagszámig számolt Taylor-sorával közelítjük.

A linearizált hálózati modell megengedi nekünk, hogy a kapcsolásunkat az elméleti villamosságtan lineáris
hálózatszámítási eszközeivel kezdjük el vizsgálni. Ennek megfelelően értelmezhetünk egy átviteli karakterisztiká-
ját (vagy átviteli függvényét, megfelelő általánosításokkal élve), mely a frekvencia függvényében határozza meg
a kapcsolás bemenetére érkező szinuszos jel komponenseinek amplitúdóerősítését (amplitúdó karakterisztika) és
fázistolását (fáziskarakterisztika).

Kisjelű szimuláció futtatásakor a hálózat gerjesztését a független források fogják biztosítani. Ennek megfele-
lően a független források paraméterezésénél be kell állítani az AC amplitude értéket a szimulációnak megfelelő
értékűre. Fontos megjegyezni, hogy a kisjelű szimuláció futtatásakor csakis a linearizált hálózatot veszi figye-
lembe a szimulátor, így nincs szükség a gerjesztő mennyiségeket kicsiny értékűre választani. Ennek megfelelően
a gyakorlatban az AC amplitúdót rendszerint 1 V-ra választjuk, hiszen így a logaritmikus skálán ábrázolva
az egységnyi erősítéshez a 0 dB-es érték fog tartozni! Kisjelű szimulációra láthatunk egy példát a 10. ábra
kapcsolását felhasználva, hozzáadva a következő AC direktívát:

.ac dec 100 1 1meg

A direktíva dekádonként 100 pontban 1 Hz-től 1 MHz-ig meghatározza a kapcsolást átvitelét. Természete-
sen itt is több lehetőségünk van a szimulálandó frekvenciák megadására. A DC sweep szimulációhoz hasonlóan
itt is tudjuk használni a lineáris, az oktáv és a lista opciókat a dekádok helyett. A direktívának köszönhe-
tően a szimulátor meghatározza a kapcsolás munkapontját, elvégzi a linearizálást és a lineáris hálózatnak
numerikusan meghatározza az átviteli karakterisztikáját. Az eredmények ábrázolásánál a vizsgált jeleket alap-
értelmezetten egy Bode-diagrammon ábrázolva láthatjuk, ahogy az a 15. ábrán láthatjuk is. Bode diagrammok
ábrázolásánál az alapértelmezett beállítás, hogy az amplitúdó- és fáziskarakterisztikákat egy ábrán ábrázolja az
LTspice, folytonos vonallal ábrázolva az amplitúdóátmenetet és szaggatottal a fázist. Az amplitúdóátmenet a
bal oldali, míg a fázisátmenet a jobb oldali skála alapján van értelmezve és alapértelmezetten az amplitúdóát-
menet dB-ben van kifejezve. Természetesen lehetőségünk van ezeket a beállításokat módosítani, ahogy azt a 6.
fejezetben be is mutatjuk.

Az ábráról leolvasható, hogy a 10. ábrán lévő differenciális jelekkel meghajtott előerősítő kimenetén kb. 42
dB-es erősítés figyelhető meg egy 15 Hz és 23 kHz közötti áteresztősávban, ezen a sávon kívül az erősítés monoton
módon csökken! Fontos megjegyezni, hogy a 15. ábra nem az erősítés értékét adja meg, hanem a differenciális
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15. ábra. Előerősítő átviteli karakterisztikája

jelek V(outp,outn) dB-ben kifejezett értékét. Ezeket a jeleket azonban tudjuk erősítésként értelmezni, hiszen
az eredeti kapcsolásban a bemeneti differenciális jelünk 1 V amplitúdójú volt, így a kimeneti jeleink egy az
egyben az erősítésnek felelnek meg!

16. ábra. Átvitel a ”Common” csomópontra

17
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Fontos megjegyezni, hogy a munkaponti linearizálás teljes mértékben figyelmen kívül hagyja a kapcsolás
nemlinearitásait! Ennek köszönhetően, ha ábrázoljuk az átvitel mellett a 10. ábra Common csomópontjának
feszültségét úgy az áteresztősávban -210 dB-es értéket láthatunk. A következő szakaszban a nagyjelű szimu-
lációk során látni fogjuk, hogy ennél az értéknél nagyságrendekkel nagyobb jeleket fogunk látni a Common
csomóponton.

4.4. Nagyjelű analízis és a .tran direktíva

A kisjelű szimuláció előnye az alacsony erőforrásigény, így relatíve könnyű a nagyszámú szimuláció futtatása.
Kisjelű szimuláció során a megoldó motornak a hálózat linearizációját csak egyszer kell végig számolnia, majd
az így adódó lineáris hálózatra minden szimulációs pontban egy algebrai egyenletrendszert kell megoldani, mely
egyszerű feladat a számítógépek számára. A módszer hátránya, hogy az így számolt megoldás csak közelítőleg
pontos és fontos nemlineáris jelenségeket elfedhet!

A pontosabb szimulációk érdekében a számítások során figyelembe kell vegyük a hálózat nemlinearitásait is!
Ennek következtében a megoldandó probléma egy nemlineáris differenciál-egyenletrendszerre vezet. Általános
esetben az ismeretlenekből álló vektorra érvényes egyenletrendszer a 3. egyenlettel írható le, ahol f tartalmazza
a hálózatra érvényes nemlineáris egyenleteket.

d

dt
~y(t) = ~f(t, ~y) (3)

Ennek az egyenletnek az általános megoldásához integráljuk az egyenletrendszer mind a két oldalát és
használjuk fel a hálózatra érvényes kezdeti feltételt: ~y(t0) = ~y0. Ennek megfelelően az ismeretlen változók
időfüggvénye a 4. egyenlet szerint alakul.

~y(t) = ~y0 +

∫ t

t0

~f(τ, ~y(τ))dτ (4)

A 4. egyenletből látható, hogy az ismeretlen időfüggvények meghatározásához numerikus integrálást kell
alkalmazzunk. A pontos numerikus integrálás érdekében kis időlépéseket kell alkalmazzunk, így az elvégzendő
számítások száma gyorsan nő.

Nagyjelű szimuláció futtatása során a hálózat gerjesztését a független források időfüggő viselkedése fogja
meghatározni, így a szimuláció futtatása előtt be kell állítani a szükséges források viselkedését a szimulációnak
megfelelően.

Nagyjelű szimuláció futtatásához a .tran7 direktívát kell hozzáadjuk a sémához. A direktíva paramétere-
inek megadásához ismét használhatjuk a grafikus szerkesztőfelületet (Simulate > Configure Analysis >
Transient) . A direktíva minimalista paraméterezéséhez elegendő a végső szimulációs időt megadjuk, ekkor a
szimulátor az áramköri komponensek értékéből számít egy becslést a szükséges időlépés meghatározásához.

.tran 100m

Abban az esetben, ha mi szeretnénk meghatározni a maximális időlépés nagyságát úgy 4 paraméter meg-
adása szükséges. Ezen paraméterek sorrendje a következő:

.tran Tprint Tstop Tstart Tmaxstep

A paraméterek magyarázata a következő: Tstop a szimulálandó időtartam hossza, Tstart a szimulált
változók mentésének kezdeti pillanata, Tprint a szimulált jelek ábrázolásakor használt időskála kezdeti értéke
és végül Tmaxstep a szimulátor által használt maximális időlépés nagysága.

A kis- és nagyjelű szimulációk összehasonlításához végezzük el az előző szakaszban ismertetett audió elő-
erősítő nagyjelű analízisét. Ehhez a 10. ábra kapcsolását egészítsük ki a következő direktívával:

7A direktíva neve a Transient angol szó rövidítéséből származik, mely az időben változó jelek leírását takarja.
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.tran 0 40m 30m 1u

Vagyis a szimulátor egy 40 ms-ig tartó tranziens szimulációt fog végezni, maximum 1µs-es időlépést hasz-
nálva, a szimulált jeleket csak 30 ms után kezdi el elmenteni és a megjelenítés során az idő tengelyt 0-tól kezdve
rajzolja ki. Mivel csak 30 ms-től mentjük az adatokat, így az ábrázolt hullámformák 10 ms hosszú időtartamot
ölelnek fel.

Ha ábrázoljuk a kimeneti differenciális feszültséget és a common csomópont feszültségét akkor szembetűnően
láthatóvá válik a hálózat nemlinearitásának hatása! Az ábráról leolvashatjuk a kimeneti jel amplitúdóját, mely
136 mV-ra adódott, ennek megfelelően az erősítés dB-ben kifejezett értékére 42.6 dB-t kapunk, mely igen
közel van a korábbi AC szimuláció során kapott maximális értékhez! Azonban a common csomópont feszültsége
esetében nem ez a helyzet. A tranziens szimuláció eredményeként 396 µV-ot kapunk, ez -8 dB-es erősítésnek
felel meg, mely nagyságrendekkel több, mint az AC szimulációnál számolt -210 dB-es érték!

További érdekességként figyeljük meg, hogy a common csomóponton előálló szinuszos jel frekvenciája két-
szerese a fölötte lévő kimeneti jel frekvenciájának! Ez a viselkedés alapvetően idegen a lineáris hálózatoktól,
hiszen azok csak a bemeneti jel amplitúdóját és fázisát változtathatják meg! A jelenség az előerősítőben lévő
tranzisztor nemlineáris karakterisztikája miatt lép fel! A tranzisztor bemeneti karakterisztikáját egy exponen-
ciális függvény írja le, és mint exponenciális függvény a Taylor-sora tartalmazni fog egy négyzetes tagot. Ez a
négyzetes tag felelős a frekvencia kétszereződéséért, a szinuszos függvények hatványazonossága következtében.

sin2(x) =
1− cos(2x)

2
(5)

Tehát, ha egy szinuszos jelet négyzetre emelünk, úgy az eredmény tartalmazni fog egy 0 Hz-es, azaz időben
állandó, és egy kétszeres frekvenciájú komponenst. A nemlinearitásból származó 0 Hz-es tag nem látható az
ábrán, mivel a kapcsolásban a kimenet egy leválasztó kondenzátoron keresztül van kivezetve, így az egyen-
áramú részek tökéletesen le vannak választva! Ez a frekvencia többszöröződés általánosan igaz a nemlineáris
hálózatokra!

17. ábra. Nagyjelű szimulációs eredmények

Audiótechnikában és jelátvitelek esetében a jelfeldolgozó hálózatok nemlineáris torzítását a Teljes Harmo-
nikus Torzítással (THD-vel rövide8) jellemzik. Ez a mérőszám megmutatja, hogy a jel effektív értékének RMS9

8Az angol Total Harmonic Distortion szakkifejezésből.
9Az angol Root Mean Square rövidítéséből. A szakkifejezés az effektív érték számításmódjára utal, ahol a jel négyze-

téből számolt integrálközépérték gyökét képezzük.
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amplitúdó hány %-a adódik a felharmonikus tartalomból. Mivel szinuszos jelek esetében az RMS amplitúdó a
különböző frekvenciájú komponensek négyzetes közepével arányos így a THD a 6. formula alapján számolható.
A formulában Ai az i-edik harmonikus amplitúdóját jelöli, ahol az 1-es index az alapharmonikus.

THD =

√∑∞
i=2 A

2
i√∑∞

i=1 A
2
i

(6)

A harmonikus torzítás erősen jelszintfüggő, hiszen a torzítások a munkaponttól távoli nemlinearitásokból
erednek. Ennek megfelelően a gerjesztés amplitúdóját változtatva megfigyelhetjük, hogyan változik a torzítás
mértéke. A szimulációs eredményeket az 1. táblázatban foglaltuk össze. Mint látható 20 mV-os jelamplitúdó
felett a torzítás jelentősen növekszik! Ez a torzítás a jelalak torzulásával jár együtt, ahogy azt meg is figyelhetjük
a 18. ábrán a szinuszos jel trapézodásából! A THD számításához szükséges szimulációs beállításokat az 5.
fejezetben ismetetjük bővebben a .four direktíva tárgyalásakor!

A [mV] THD [%]
1 0
2.154 43 0.001 416
4.641 59 0.009 175

10 0.043 222
21.5443 2.749 631
46.4159 6.929 302
100 7.685 063

1. táblázat. Teljes harmonikus torzítás változása

18. ábra. Nagyjelű torzítás megjelenése 100 mV-os bemeneti jel esetén

Bonyolult hálózatok és szimulációk esetén szükséges lehet, hogy a hálózatot egy adott kezdeti állapotból
kiindúlva szimuláljuk. Ekkor a triviális megoldás, hogy olyan gerjesztő jeleket állítunk be, mellyel a hálózat véges
időn belül beáll a szükséges kiindulási állapotba, ezután pedig elkezdhetjük menteni a szimulációs adatokat.
Ennek a módszernek a használatakor igen gyorsan abban a helyzetben találhatjuk magunkat, hogy a szimulációs
idő nagyon nagy részét csupán a kezdeti állapot beállítására használjuk fel, így a processzorunk nagyrészt
feleslegesen számol. Ennek a problémának egy jobb megoldási módja a beépített .ic direktíva használata!

A direktíva használatával beállíthatjuk csomópontok kezdeti potenciálját, ezzel beállítva a csomóponton lévő
kapacitások kezdeti töltésmennyiségét is, valamint beállíthatjuk a kapcsolásunk tekercseinek kezdeti áramait.
A direktívának köszönhetően a numerikus megoldó a hálózat kezdeti állapotának számolásánál figyelembe fogja
venni az általunk megadott paramétereket, és azokkal konzisztens kezdeti megoldásból kezdi el numerikus
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integrálással számolni a későbbi időpillanatokat. Ezzel a módszerrel kezdeti értékek megadásánál nem kell a
hálózat összes csomópontjára és tekercsére kezdeti értéket megadjunk, csupán a számunkra fontosaknak!

19. ábra. Kezdeti értékek beállítása

A 19. ábrán láthatunk egy példakapcsolást, amin szemléltettük a kezdeti értékek beállítását egy T to-
pológiájú LC szűrőn keresztül. Az ábrán látható direktívával az L1-es tekercset árammentes kezdőállapottal
számoljuk, míg a C1-es kondnzátor feszültségét 2 V nagyságúra állítottuk be. Mivel az L2-es tekercsre nem
állítottunk be kezdeti feltételt, így ott a szimulátor a tekercset egy rövidzárral helyettesítette, feltéve, hogy a
hálózat egy állandósult állapotból indult ki. Ennek megfelelően az L2 tekercs árama 2 A-es értékkel indul, ahogy
az a C1-es kondenzátor feszültségéből és az R1-es ellenállás értékéből következik. A kiadódó hullámformákat
a 20. ábrán láthatjuk.

.ic I(L1) = 0 V(mid) = 2

20. ábra. Hullámformák kezdeti értékekkel
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4.5. Zajszimulációk és a .noise direktíva

Az elektronika egyes alkalmazási területein fontos szempont a kapcsolások vizsgálata zajos környezetben. Ti-
pikusan ilyen alkalmazási terület a nagyfrekvenciás környezetben alkalmazott kis zajú erősítők tervezése. Egy
erősítő zaján azt az additív zajteljesítményt értjük, amit az áramkör a jelátviteli láncba történő beiktatásával
hozzáad a jelekhez.

Az elektronikai kapcsolásokban előforduló zajokat több alkatrész és fizikai folyamat termeli, azonban ezekkel
a folyamatokkal ebben a dokumentumban nem foglalkozunk. Szimulációs szempontból számunkra az alkatrészek
saját zaja és annak szimulációja fontos, így a továbbiakban csak ezekre fókuszálunk.

A különféle zajok karakterizációjára a teljesítménysűrűség-spektrumot szokás használni. Ez a spektrum
megmutatja, hogy az adott frekvencián és annak kicsiny környezetében a zajnak mekkora teljesítménye található
meg.

Legelső körben az ellenállások termikus zaját vizsgáljuk. A környezeti hőmérséklet függvényében minden
ellenállással bíró áramköri komponens zajt termel. Ezt a zajfajtát Johnson és Nyquist neveihez kötjük, azonban
fehér zajnak is szokás nevezni, hiszen a zaj teljesítménysűrűség-spektruma független a frekvenciától.10 Ennek
megfelelően egy ∆f sávszélességű tartományon belül megtermelődő termikus zaj teljesítményét és az ebből
kifejezhető ekvivalens feszültség- és áramértékeket a 7. formulákkal határozhatjuk meg. A formulákban szereplő
kB a Boltzmann állandó, míg T az abszolút hőmérséklet.

P = kBT∆f

P =
U2
n

R
= I2nR

(7)

Felhasználva ezeket az összefüggéseket kifejezhetjük a termikus zajjal ekvivalens RMS feszültség- és áram-
értékeket a 8. formulákkal. Ennek megfelelően a zajos ellenállásokat modellezhetjük egy zajmentes ellenállással
és egy soros zaj-feszültségforrással, vagy egy párhuzamos zaj-áramforrással.

Un,RMS =
√
kBT∆fR

In,RMS =

√
kBT∆f

R

(8)

Félvezető komponensekben gyakran előforduló zaj az ún. rózsaszín, villódzó vagy 1/f zaj. Ennek a zajnak
a teljesítménysűrűség-spektruma egy frekvenciával fordítottan arányos résszel rendelkezik. Az 1/f zaj modelle-
zésére az aktív áramköri komponensek (tranzisztorok, IC-k és egyéb félvezetők) gyári modelljei extra forrásokat
tartalmaznak. Ezeknek a forrásoknak az értékei erősen függenek az adott eszköz munkapontjától, így a zajszi-
muláció során az áramköri munkapont beállítása kiemelten fontos.

A zajok hatására az egyes csomópontokon megjelenő zajkomponensek frekvenciafüggő vizsgálatához a zajfe-
szültség spektrumát szokás felhasználni. Ezt a zajfeszültséget azonban nem mint egy konkrét jel feszültségének
kell értelmezni! A zajfeszültség adott frekvenciájú komponense a zajteljesítmény azonos frekvenciájú és annak
egy adott sávszélességén (általában 1 Hz) belül lévő komponenseiből számolt teljesítményből adódik. Ennek
megfelelően a zajfeszültség szokásos mértékegysége a nV/

√
Hz.

A zajszimuláció illusztrálására alakítsuk át az előző szakaszban ismertetett differenciális audió előerősítő
kapcsolást a 21. ábrának megfelelően. Zaj szimulációk futtatásához egészítsük ki a sémát a következő .noise
direktívával:

.noise V(outp, outn) V1 dec 100 1 1meg

10A különböző színű zajokat a teljesítménysűrűség-spektrumuk alapján különböztetjük meg. A kis frekvenciákat a
vörös, míg nagy frekvenciákat a kék fénynek feleltetjük meg, így a kiadódó spektrumot, mint a látható fény spektrumot,
tudjuk értelmezni és színekhez rendelni.
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A direktíva paramétereivel beállítjuk, hogy a szimuláció során a kimenetünk az outp és outn csomópontok
közötti feszültség, a kapcsolás zajmentes bemenete a V1 forrás, a kimeneti spektrumot pedig dekádonként 100
ponttal szeretnénk szimulálni 1 Hz és 1 MHz között. Az így előálló zajteljesítmény-sűrűség spektrumból számolt
feszültségspektrumot a 22. ábrán tekinthetjük meg. Az ábrán jelöltük a zajspektrum nevezetes szakaszait. Az
alul- illetve felüláteresztő jelleg az erősítő kapacitásai miatt alakul ki, melyek nemcsak a bemeneti jelet, de a
zajt is szűrik. A középső lankás terület az ellenállások termikus zajából adódik és a frekvencia csökkenése miatti
emelkedés pedig a tranzisztorok 1/f zajából adódik.

21. ábra. Zajszimulációs példakapcsolás 22. ábra. Zajszimuláció eredménye

Ha kíváncsiak vagyunk a szimulált frekvenciatartományon belüli zaj RMS feszültségére, úgy a szimulált jel
nevére Vonoise a CTRL + bal egérgomb lenyomásával kattintva egy felugró ablakban megkapjuk az integrált
zajfeszültség RMS értékét. Esetünkben ez az érték 14.243 µV-ra adódott, vagyis az előerősítők beiktatásával
14.243 µVRMS-nyi zajt is beiktattunk a jelátviteli láncunkba!

5. Összetett szimulációk futtatása

Az eddigiek során bemutattuk és megismertettük a kezelőfelület használatát, valamint bemutattuk az LTspice
egyszerűbb szimulációs lehetőségeit. Ebben a fejezetben az szoftver által szolgáltatott összetettebb funkciók
megismerésére fogunk fókuszálni, melyek lehetővé teszik a szoftver alkalmazását a mindennapi mérnöki életben
előforduló problémák modellezésére és számítására.

5.1. Parametrikus szimulációk

Az LTspice lehetőséget biztosít az alkatrészértékek parametrizálására ún. sémaváltozók bevezetésével. Ezeket a
változókat felhasználhatjuk komponensek értékeinek megadására, vagy mint matematikai változók melyek for-
mulákba illeszthetők be. Az LTspice-ban paraméterek megadása a { } zárójelekkel történik. A kapcsoszárójelek
között szereplő kifejezések a szimulációk futtatása előtt kiértékelődnek és a szimuláció már a kiértékelt valós
számokkal fog végig futni. Paraméterezés használatának illusztrálására nézzük meg a 23. ábra kapcsolását.

Az ábrán egy kaszkádosított feszültségosztót valósítottunk meg, melyben az első fokozat az R1 és R2
ellenállásokból, míg a második fokozat az R3 és R4 ellenállásokból áll. Az ellenállásosztó minden ellenállása
egy parametrikus ellenállásértéktől függ, ez a paraméter az Rpar változó. A paraméter függvényében az R1-R4
ellenállások a sémaváltozó 1x, 2x, 10x és 20x szeresét veszik fel, ezzel skálázva az ellenállásosztó be- és kimeneti
impedanciáját. A sémán elhelyezett parametrikus sémaváltozók értékeinek megadásához a .param direktívát
kell használjuk. Ez a sémán a következő szintaktikával szerepel.

.param Rpar = 1k
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23. ábra. Változó paraméterek használata

A param direktíva után a paraméterek és értékeiknek megadása történik ún. kulcs-érték párok alkalmazá-
sával. Ebben az esetben az Rpar változónknak 1 kΩ-s értéket adunk. Ezt az értéket a szimulátor behelyettesíti
a kapcsoszárójelek közötti kifejezésekbe (R1-R4 ellenállások értékei), majd elvégezi a szükséges szimulációt,
amely a munkapont meghatározás ebben az esetben. Ezzel a módszerrel könnyen tudjuk állítani a séma több
alkatelemének az értékét egyidejűleg.

A kapcsoszárójelek közötti kifejezésekben akár bonyolultabb matematikai formulákat is alkalmazhatunk az
adott komponens értékének megadásánál. Ebben az esetben az alkalmazható matematikai és logikai függvények
nagyrészt megegyeznek a tetszőleges viselkedésű források esetén elérhetőkkel, így a bővebb lista felelevenítése
érdekében kérjük az olvasót a 3. fejezet B forrásokról szóló szakaszának átismétlésére.

Valóságos szimulációs modellek esetében előfordul, hogy a séma kapcsolását nem csupán paraméterekkel
szeretnénk ellátni, hanem ezeket a paramétereket szeretnénk változtatni egy előre definiált minta alapján. Eb-
ben az esetben tudjuk használni a .step direktívát. Ehhez módosítsuk a 23. ábra .param direktíváját a
következőképpen:

.step param Rpar 1k 10k 500

Ezzel a direktívával megadhatjuk az LTspice számára, hogy a megadott szimulációt végezze el az Rpar változó
értékeinek változtatásával. A paraméter értékeinek sora megadható a 3. fejezet .dc szimulációjánál látottakkal
(lin, dec, oct és list) módon. Ennek értelmében a fenti direktíva az Rpar értékét 1 kΩ és 10 kΩ között fogja
változtatni 500 Ω-s léptékekkel, ennek eredményeként összesen 19 szimulációt fog lefuttatni a szoftver.

A .step direktívával nem csak paraméterek értékeit tudjuk változtatni, hanem független források értékeit is
(hasonlóan a .dc direktíva felhasználásával), hőmérsékletet is a .step TEMP direktívával, valamint áramköri
modell paraméterét is. Ha csak pár hőmérsékleti értéket szeretnénk változtatni, úgy használhatjuk a .temp
direktívát is, mely után fel kell sorolnunk a szimulálandó hőmérsékleti értékeket ◦C-ban értelmezve. Ezen kívül
lehetőségünk van több paramétert is változtatni, ebben az esetben a megadott paraméterek minden lehetséges
kombinációját elő fogja állítani a szoftver, így a teljes paramétertér le lesz fedve, azonban ennek következtében
gyorsan megnőhet a szükséges szimulációk száma. Gondoljunk csak bele, ha 3 paramétert szeretnénk 20 külön-
böző értékkel szimulálni, úgy a lehetséges kombinációk száma 203 = 8000, azaz ennyi szimuláció futtatása lesz
szükséges!

Abban az esetben, ha nem szeretnénk a sémaváltozók által kifeszített paramétertér összes lehetséges kom-
binációját szimulálni, csak bizonyos kombinációkat, lehetőségünk van a table() függvény használatára. A
függvény a sémaparaméterek összetartozó kombinációinak megadását teszi lehetővé. Az összetartozó kombiná-
ciókat egy indexváltozóval tudjuk megkülönböztetni, és a szimulációk során ezt az indexváltozót tudjuk léptetni
a .step direktíva felhasználásával. A módszer illusztrálásához változtassuk meg a 23. ábra kapcsolásának R3
és R4 ellenállás értékét {Rpar2} és {2*Rpar2} kifejezésekre és módosítsuk a sémán szereplő direktívákat a
következők szerint:
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.op

.param Rpar=table(x,0,1k,1,2k,2,5k,3,10k)

.param Rpar2=table(x,0,100,1,200,2,500,3,1k)

.step param x list 0 1 2 3

A fenti direktívák használatával a kaszkádosított feszültségosztónkon a 2. táblázat szerinti paraméterkom-
binációk fognak lefutni.

x 0 1 2 3
Rpar 1k 2k 5k 10k
Rpar 100 200 500 1k

2. táblázat. Meghatározott sémaváltozókombinációk megadása

Több paraméter változtatása esetén az ábrázolandó mennyiségek és jelek ábrázolása nem magától értető-
dő feladat, így erre a 6. fejezetben még vissza fogunk térni és részletesen be fogjuk mutatni, hogyan lehet
kiválasztani a paraméterhalmaz futó változóját.

5.2. Monte Carlo szimulációk

Az eddigiek során ismertetett szimulációs eljárások és kapcsolások során a sémán szereplő alkatrészek fix és
névleges értéket képviseltek, és a szimulátorunk ezen értékek alapján végezte el a szükséges számításokat. A va-
lóságos alkatrészeink ezzel ellentétben ugyan egy fix értékkel rendelkeznek (környezeti változásoktól eltekintve),
azonban ezek az értékek általában nem esnek egybe az alkatrész névleges értékével. Ezzel a ténnyel az alkatrész-
gyártók is tisztában vannak, így az alkatrészekhez hozzárendelnek egy toleranciaosztályt is. Ennek megfelelően
az általunk megvásárolt 1 kΩ-s 5%-s ellenállás tényleges ellenállása a névérték körül 5%-t tud szórni, vagyis a
névleges 1 kΩ-s ellenállás értéke 950 Ω és 1050 Ω között bármi lehet. A névértéktől vett eltérés következtében
kapcsolásunk viselkedése megváltozhat pl. a szűrőnk törésponti frekvenciája eltolódik, vagy a feszültségosztó
kimeneti feszültsége megváltozik. Ezen hatások vizsgálata érdekében szükséges lehet változó paraméterekkel
többször elvégezni a szimulációt és a szimulációs eredményekből statisztikát készíteni. A metodika ennek kö-
szönhetően lett elnevezve Monte Carlo módszernek, hiszen a Monacoban található város a kaszinóiról, így a
szerencsejátékról és a valószínűségekről híres.

Az alkatrészparaméterek véletlenszerű változtatásához véletlenszámokra és parametrikus alkatrészértékekre
van szükségünk. Ehhez kihasználhatjuk, hogy az LTspice a {}-k között megadott kifejezéseket a szimuláció
lefuttatása előtt kiértékeli és behelyettesíti, valamint a kapcsoszárójelek közötti kifejezések tartalmazhatnak
különböző matematikai függvényeket is. Monte Carlo szimuláció során különböző valószínűségi eloszlásokkal
tudjuk befolyásolni paramétereink értékeit. A két leggyakrabban használt függvény a mc és a gauss. Előbbi
függvény egyenletes, míg utóbbi Gauss-eloszlású véletlen számokkal tér vissza minden egyes futtatáskor. A
függvények használatához meg kell adnunk azok argumentumait is. Az mc függvény két argumentumot vár
mc(x, y) formában és visszaad egy x(1+y) és x(1−y) közötti értéket, egyenletes eloszlással. A gauss függvény
ezzel ellentétben csupán egyetlen paramétert vár gauss(x) formájában, majd visszaad egy 0 várható értékű és
x szórással rendelkező Gauss-eloszlású véletlen értéket. A függvények használatához figyeljük meg a 24. ábra
kapcsolását.

A kapcsolás egy egyszerű két darab ellenállásból álló feszültségosztót valósít meg. R1 és R2 ellenállások
értékeit az Rpar és Rsigma paraméterek segítségével határozzuk meg a 9. egyenletek szerint.
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24. ábra. Monte Carlo szimulációs példakapcsolás

R1,low = Rpar(1−
Rsigma

Rpar
) = Rpar −Rsigma

R1,high = Rpar(1 +
Rsigma

Rpar
) = Rpar +Rsigma

R1 ∼ U(R1,low, R1,high)

R2 ∼ N (µ = Rpar, σ2 = R2
sigma)

(9)

A fentieken kívül a sémán megtalálható még a .param direktíva, mellyel megadjuk a felhasznált paraméterek
értékeit (Rpar és Rsigma) formájában, valamint megadjuk, hogy a munkaponti .op szimulációt 1000x futtassuk
le. A futások számának megadása a .step param run direktívával történt.

A szimulációt elvégezve a kérdéses jelek pl. az out csomópont feszültsége vizsgálhatóvá válik. Ezzel a
módszerrel ugyan meg tudjuk vizsgálni a véletlenszerű alkatrészértékek hatását a számunkra fontos jelekre és
paraméterekre, azonban az eredményekről számszerű statisztika készítésére nincs lehetőségünk az LTspice-on
belül. Ehhez a sémán automatizált mérési utasításokat kell elhelyezzünk, és a kiadódó logfájlból kell kinyerjük
a szimulációs eredményeket, melyek utána kiértékelhetők az általunk választott adatkezelő szoftverrel pl. Excel,
Matlab vagy Python segítségével.

5.3. Áramkör vizsgálata diszkrét frekvenciákon

Az előző fejezetben ismertetett nagyjelű tranziens szimuláció kapcsán bevezettük a Teljes Harmonikus Torzítás
fogalmát. Ezzel a mérőszámmal számszerűsíthető egy nemlineáris hálózat torzítása, azaz az egyfrekvenciájú
szinuszos bemenet hatására létrejövő felharmonikus tartalom. Ebben a szakaszban bemutatjuk, hogy hogyan
automatizálható ennek a mérőszámnak a meghatározása LTspice segítségével. A szimuláció során használjuk
fel a 10. ábra kapcsolását és egészítsük ki azt a következő direktívákkal:

.tran 0 40m 30m 1u

.four 1k 10 V(outp,outn)

A .tran direktíva hatására egy nagyjelű szimulációt végzünk 40 ms-ig, és annak csak az utolsó 10 ms-t
rögzítjük, míg a .four11 direktíva segítségével megadjuk, hogy a bementi frekvenciánk 1 kHz, kimeneti jelünk
az outp és outn csomópontok közötti feszültség és ennek a jelnek szeretnénk 10 db harmonikusát meghatározni,
beleértve az alapharmonikust is. A szimuláció eredményeként előáll a 25. ábra szerinti kimenet, melyet a
logfájlban találunk. A logfájl előhívásához használjuk a (View > SPICE Output Log) menüpontot vagy
a CTRL+L gyorsgombot.

11A direktíva a Fourier név rövidítése.
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25. ábra. Diszkrét frekvenciájú Fourier-komponens analízis eredménye

Az eredményeket megnézve látható, hogy az analízis a jelek 1 periódusából számolt értékeit tartalmazza
(N-Period=1), ez azonban beállítható a .four direktíva módosításával. Pl. ha szeretnénk a jel 5 periódusát
felhasználni a számítások elvégzéséhez, úgy a direktívánk a következőképpen módosul:

.four 1k 10 5 V(outp,outn)

Az eredmények között megtalálhatjuk az egyes harmonikusokhoz tartozó jelamplitúdók és fázisok értékeit,
valamint ezen értékek alapharmonikusra normalizált értékeit. A logfájl végén pedig számszerűsítve megtalál-
hatjuk a számított részleges (Partial) és teljes (Total) harmonikus torzítás értékeit.

5.4. Kétpólus és kétkapu paraméterek számítása

Nagyfrekvenciás technikában alkalmazott áramköri elemek esetében gyakran találkozhatunk az illesztett be-
és kimenetek, illetve impedanciák fogalmával. Ezen áramköri elemek legtöbbször, mint lineáris kétpólusok
és kétkapuk vannak kezelve, ennek megfelelően alkalmazhatjuk rájuk a lineáris hálózatelmélet fogalom- és
eszköztárát. Az LTspice-ban a hálózati portokkal kapcsolatos szimulációk elvégzéséhez a .net direktívát kell
használjuk, mely a network angol szó rövidítéséből származik. A direktíva mellett szükséges még egy .ac
direktíva futtatása is, mellyel a szimulálandó frekvenciatartományt tudjuk megadni és ezen a tartományon
fognak lefutni a .net direktíva számításai.

Kétpólusok vizsgálatához meg kell adjuk a kétpólus kapcsaira csatlakozó feszültséforrás azonosítóját, vala-
mint opcionálisan megadhatjuk a kétpólust meghajtó forrás belső ellenállását. Ez a belső ellenállás a nagyfrek-
venciás technikában leggyakrabban 50 vagy 75 Ω. Kétpólusvizsgálathoz figyeljük meg a 26. ábra kapcsolását
ahol egy reflektorral ellátott dipól antenna illesztőhálózatát szimuláltuk. Az antenna frekvenciafüggő komplex
impedanciáját egy egyedi szimbólummal és egy aláramköri leírást tartalmazó fájlal adtuk meg.12

.ac lin 1000 2G 2.9G

.include antennaImpedance.sub

.net V1 Rin = 50

.net V2 Rin = 50

A felhasznált direktívákkal a 2.4 GHz-es WiFi sáv és annak 400 MHz-es környezetében (2 GHz-től 2.9 GHz-
ig) végzünk összesen 1000 különböző frekvencián szimulációkat, majd pedig ezen tartományon meghatározzuk
a kétpólusok viselkedését leíró paramétereket a frekvencia függvényében. Az include direktíva húzza be az an-
tenna viselkedését leíró .sub fájlt, mely az antenna bemeneti impedanciáját modellező aláramkört tartalmazza.

12Az antenna bemeneti impedanciája az antennageometria erős függvénye. A bemeneti impedancia frekvenciafüggésé-
nek meghatározásához az elektromágneses tér numerikus számítása szükséges. Ez a feladat túlmutat ezen dokumentum
hatáskörén, így nem részletezzük. Az érdeklődő olvasó figyelmébe ajánljuk a Matlab Antenna Toolbox programját.
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26. ábra. Kétpólusok vizsgálata .net direktívával

Kétpólusok esetében az LTspice meghatározza a kétpólus bemeneti impedanciáját, bemeneti admintanciáját és
a reflexiótényezőjét13. Ezen paraméterek a frekvencia függvényében ábrázolhatóak a Zin(V1), Yin(V1) és
S11(V1)14 mennyiségek ábrázolásával.

Fontos megjegyezni, hogy a .net direktívák esetében a bemeneti és a későbbiekben a kimeneti ellenállás
megadása opcionális és bizonyos esetekben el is hagyható. Alapértelmezés szerint minden kapu 1 Ω-s ellenállás-
sal van lezárva. A bemeneti feszültségforrás soros ellenállását beállítva, valamint a direktívát kiegészítve az Rin
kulcsszóval ez az érték lecserélhető. A két módszer a szimuláció során eltérő eredményeket tud adni, így ügyelni
kell rájuk! A forrás soros ellenállásának beállításával az .ac szimuláció során minden jel ezen ellenállás figye-
lembevételével fog szimulálódni, míg ha csak a .net direktívában adjuk meg, úgy csak a hálózati paraméterek
számításánál lesz figyelembe véve!

A 27. ábrán megfigyelhetjük, hogy az antenna és a jelforrás közé kapcsolt illesztőhálózatnak köszönhetően
a jelforrás az antennát egy tisztán 50 Ω-s impedanciaként látja a WiFi sáv környezetében. Az ábrán a folytonos
vonalak az impedanciák valós részét ábrázolják és a bal oldali skála alapján értelmezendőek, míg a szaggatott
vonalak a képzetes részt mutatják és a jobb oldali skála alapján értelmezendőek.

27. ábra. Antenna bemeneti impedanciája illesztőhálózat nélkül (zöld) és illesztőhálózattal (kék)

Az illesztőhálózatnak köszönhetően az antennára jutó hatásos teljesítményt 45 - 55%-kall tudtuk megnövelni,
valamint ezzel egyidőben illesztettük is az antennát a meghajtó hálózatához, ezáltal minimalizálva a gerjesztő
hálózat felé reflektálódó teljesítményt.

Kétkapuk szimulálásához a .net direktívát még ki kell egészíteni a kimeneti kaput képező jellel. Ezt kétfé-
leképpen tudjuk megadni a szimulátor számára. Egyrészt megadhatjuk a kimeneti kapu kapcsait egy feszült-
ségjellel, avagy megadhatjuk a kimeneti kaput lezáró ellenállást.

A 28. ábra kapcsolásain a bal oldalon egy rezisztív impedanciaillesztő hálózatot láthatunk, melynek be-
menetét a V3-as feszültségforrás képezi és kimenetét pedig az R4-es ellenállás zárja le. Az ábra jobb oldalán

13Nagyfrekvenciás technikán feszültség és áramjelek mérése igencsak nehézkes tud lenni, hiszen a mérendő mennyiségek
erősen függenek a mérővezetékek hosszától és azok egymáshoz képesti helyzetétől. Ezen a területen ezért általában
teljesítmények áramlását mérik és meghatározzák a kétpólusra érkező és az onnan reflektálódó teljesítményeket.

14Nagyfrekvenciás technikában előszeretettel használják a kétpólusok és sokkapuk leírására az ún. szórási paramé-
tereket. Ezzel a leírásmóddal megadhatók a sokkapuk portjaira érkező és onnan visszaverődő teljesítményhullámok.
Kétpólusok esetében az S11 paraméter gyakorlatilag a komponens reflexiótényezőjével egyezik meg.
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28. ábra. Impedanciaillesztő kétkapu hálózatok

egy reaktív illesztőhálózat figyelhető meg. Mind a két hálózat a kimeneti valós 75 Ω-s ellenállást illeszti a
bemeneti valós 50 Ω-ra, azonban a rezisztív hálózat frekvenciafüggetlenül teszi ezt miközben a teljesítményből
10 dB-t disszipál. Ezzel ellentétben a reaktív változat frekvenciafüggően végzi az impedanciaillesztést, azonban
teljesítményt nem disszipál!

.net I(R4) V3

.net V(out) V4 Rin = 50 Rout = 75

Az első direktíva felhasználásával megadhatjuk, hogy a 28. ábra rezisztív illesztőhálózatának az R4-s el-
lenállás a lezárása és a V3-as forrás a gerjesztése. Figyeljük meg, hogy ebben az esetben nem adtuk meg a
bemeneti és kimeneti impedanciákat, hiszen a V3-as forrásnál beállítottuk annak soros ellenállását, valamint a
kimeneti portot egy ellenállás áramával határoztuk meg, így automatikusan ezen ellenállás értéke tekintendő
illesztett lezárásnak. A direktíva második sorával a reaktív hálózat kimenetét és bemenetét állítottuk be, vala-
mint megadtuk a kapuk referencia ellenállásait. Fontos megjegyezni, hogy a kétkapuparaméterek számításakor
a kimeneti lezárás figyelembe lesz véve, így azt külön a kapcsoláson beiktatni nem kell!

Kétkapuk esetében az LTspice meghatározza a kétkapuk viselkedését leíró impedancia-, admintancia-,
hibrid- és szórási mátrixokat, ezen kívül a kapuk felé néző be- és kimeneti impedanciákat is.

6. Szimulációs eredmények vizualizációja és utófeldolgozása

Az előző fejezetekben megismertettük az olvasót az LTspice alapvető használatával, beleértve a különböző kom-
ponensek beállítási lehetőségeit valamint a futtatható szimulációkat. Ebben a fejezetben bemutatjuk az LTspice
utófeldolgozást segítő és az elvégzett szimulációk eredményeinek vizualizációját támogató funkcióit.

6.1. Hullámformák ábrázolása

Alapértelmezés szerint a szimulációk lefutását követően a sémaszerkesztő mellett megjelenik a hullámforma
megjelenítő ablak is. Ebben az ablakban tudjuk ábrázolni a különböző jeleinket a szimulációs lépések függvé-
nyében. A szimulációk végeztével a hullámforma megjelenítő ablak lesz aktív, így a séma különböző vezetékei
fölé navigálva az egérrel több új szimbólum jelenik meg a szokásos egérkurzor helyett. Az egyik leggyakrabban
használt eszköz a vezetékek potenciálját leolvasó piros színű feszültségmérő tű. Ebben a pozícióban maradva,
ha az ALT billentyűt is lenyomva tartjuk, úgy az adott vezetéken átfolyó áramot tudjuk megmérni a lakatfogó
ikonnal. Ebben az esetben a vezeték áramát a kék színű referenciairány mutatja majd. Standard kétpólusokra
navigálva hasonlóan megmérhetjük a kétpóluson átfolyó áramot. Ha közben az ALT billentyűt is lenyomva
tartjuk, úgy megjelenik a hőmérő ikon, mellyel a kétpólus teljesítményét tudjuk leolvasni. Végül pedig ha egy
több kivezetéssel rendelkező sokpólussal van dolgunk, úgy az adott pólus kapcsai felé navigálva megjelenik
az áramszimbólum nélküli lakatfogó, mellyel az adott kivezetés áramát jeleníthetjük meg. Az ikonokat és a
hozzájuk tartozó pozíciókat a 29. ábrán szemléltetjük.
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29. ábra. Különböző mérőeszközök villamos jelek megjelenítéséhez

A további lehetőségek illusztrációja végett módosítsuk az 1. ábra kapcsolását a 30. ábra szerint. A szimu-
lációk során az R2 ellnállás értékét változtatjuk a .step direktívával 1 mΩ és 10 kΩ között 10 Ω-s lépésenként.
A szimuláció végeztével ábrázoljuk a kimeneti feszültséget (vout csomópont potenciálja) és a kimeneti áramot
(R2 ellenállás árama), így a 31. ábrán látott hullámformákat kapjuk.

30. ábra. Paraméterezett feszültségosztó kapcsolás

Mivel az R2 ellenállás sémára történő elhelyezésekor az 1-es csomópont került alulra és a 2-es felülre, így az
alapértelmezett áramirány az ellenálláson alulról felfele mutat, így a rajta átfolyó áram előjele negatív értékű,
ahogy az a 31. ábra jobb oldali tengelyén látszik is. A negatív áramértéket elkerülhetjük, ha a sémaszerkesztő
felületen megfordítjuk az R2 ellenállást, vagy a hullámforma megjelenítőn az I(R2) jelre jobb egérgombbal
kattintunk és a felugró Expression Editor felületen átírjuk az ábrázolandó kifejezést -I(R2)-re!

Az R2 ellenálláson disszipálódó teljesítményt az ALT billenytűt lenyomva tartva és az ellenállásra kattintva
tudjuk ábrázolni a legegyszerűbben. Ekkor megjelenik egy új görbe az ábrán, valamint a bal oldalt megjelenik
még egy tengely, mely az újonnan hozzáadott jelünkhöz tartozik.

Az ábrázolandó jeleken matematikai műveleteket is végezhetünk. Az alkalmazható függvények és operáto-
rok nagyrészt átfednek a 3. fejezetben a B forrásoknál ismertetekkel, kiegészülve néhány ábrázolásra vonatkozó
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31. ábra. Feszültségosztó kimeneti feszültsége és árama

függvénnyel. Ilyen függvény például a numerikus derivált operátora, a D() függvény. Ezeket a matematikai mű-
veleteket felhasználva ábrázolni tudjuk a kapcsolás teljesítményátadási hatásfokát. A hatásfokot úgy határozzuk
meg, hogy az R2 ellenállás teljesítményét elosztjuk a V1 forrás által leadott teljesítménnyel. A kétpólusokon
eső feszültség és a rajtuk átfolyó áram szorzata mind az R2 mind a V1 kétpólusok esetében negatív, így a
hatásfok számításakor a negatív előjelek kiesnek. Ennek megfelelően a teljesítményátviteli hatásfokot a követ-
kező formulával tudjuk számolni: V(vout)*I(R2)/(V(vin)*I(V1)). Összetettebb jelek ábrázolásához azokat
manuálisan kell az ábrához hozzáadjuk (Jobb klikk > Add Traces) , vagy az A gyorsgomb lenyomásával.
Ekkor felugrik egy ablak, melyben kiválaszthatjuk az ábrázolandó jeleket, valamint alul az Expression(s) to
add: szövegdobozba be is írhatjuk az ábrázolni kívánt mennyiségünk formuláját.

Ezzel összességében az ábránkon 4 mennyiséget ábrázoltunk, melyek mind különböző mértékegységgel ren-
delkeznek, így 4 külön skála tartozik hozzájuk (kettő bal oldalt és kettő jobb oldalt). Annak érdekében, hogy az
ábráink jobban áttekinthetőek legyenek, adjunk hozzá a hullámforma megjelenítőhöz ábrázolási síkokat (Jobb
klikk > Add Plot Pane Above/Below) opciók, vagy a P, B gyorsgombok felhasználásával. Az így meg-
jelenő ábrázolási síkra egyszerűen áthúzhatjuk az ott ábrázolni kívánt jeleinket, ha a jelek nevénél kezdjük el
vonszolni őket.

Jeleink ábrázolásakor a mértéket adó skálák automatikusan generálódnak a jelek terjedelméhez illeszkedve.
Abban az esetben, ha ezen skálák nem illeszkednek az elvártnak megfelelően a jelszintekhez, lehetőségünk van
módosítani azokon. Ehhez kattintsunk jobb egérgombbal a módosítani kívánt függőleges skálára és a felugró
ablakban állítsuk be a skála minimális és maximális értékét, a skála léptékét (lineáris vagy logaritmikus),
valamint az ábrán lévő rács osztásközét. Ha nem szeretnénk, hogy az ábránkon látszódjon a leolvasást segítő
rács, úgy azt ki tudjuk kapcsolni a (Jobb klikk > View > Grid) opció kikapcsolásával. Ezekkel a
beállítási lehetőségekkel elő tudunk állítani a 32. ábrához hasonló ábrát. Az ábrán jól látható, hogy az R2
ellenállás növelésével a teljesítményátviteli hatásfokunk ugyan monoton nő, de az átvihető teljesítmény 1 kΩ-
nál veszi fel a maximumát és onnantól kezdve monoton csökken. Maximális teljesítményátvitel esetében a
hatásfok éppen 50%!
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32. ábra. Több jel ábrázolása külön ábrázolási síkokon

Az áramköri paraméterek változtatása esetén (.step vagy a .dc direktívák használata) előfordulhat hogy az
ábránkon a vízszintes tengelyen nem a kívánt paraméter szerinti függését látjuk a jelalakjainknak. Ekkor lehető-
ségünk van a vízszintes tengelyre jobb egérgombbal kattintva beállítani, hogy melyik paramétert szeretnénk az
x-tengelyen ábrázolni valamint, hogy ezt a paramétert milyen határok között és milyen lépésközzel szeretnénk
ábrázolni, hasonlóan a függőleges tengelyek esetén.

Az ábrák pontosabb leolvashatósága érdekében lehetőségünk van kurzorok segítségével több tizedesre ponto-
san meghatározni a szimulált értéket egy adot paraméterállás esetén. Ehhez kattuntsunk egyszer a mérni kívánt
jel nevére! Ekkor a jelünkön megjelenik egy fehér célkereszt, kétszeri kattintás hatására pedig két célkereszt
formájában kettő darab kurzor adódik hozzá a jelünkhöz. A kurzorok által jelölt pontos értéket a kis méretű
felugró ablakban láthatjuk. Ebben szerepelnek az 1-s illetve 2-es kurzor horizontális és vertikális koordinátái, va-
lamint a kurzorok vertikális és horizontális különbségeiből származtatott értékek. A kurzorok pozícionálásához
horizontális irányban tudjuk őket vonszolni, míg vertikális irányban mindig a jelünkhöz fognak illeszkedni!

Az ábrázolt jelalakokon elhelyezhetünk különböző jelmagyarázó jelölőket is a (Jobb klikk > Notes &
Annotations) menüpont alpontjaiból válogatva. Ezekkel a nevezetes és fontos pontokat vagy tendendiákat
szoktok jelölni, ezzel is fókuszálva az ábrát néző mérnök figyelmét a lényeges részletekre, ahogy az a 33. ábrán
is látható. Annak érdekében, hogy az ábrázolt hullámformáink jobban láthatóak legyenek lehetőségünk van az
ábrázolási felület beállításait is módosítani a (Tools > Settings > Waveforms) menüpont alatt. Itt át
tudjuk állítani a hullámformák és kurzorok vastagságát valamint a feliratok betűtípusát és betűméretét is.

6.2. Fourier-transzformációs analízis

Villamosmérnöki munkák kapcsán nagyon gyakran előfordul, hogy a mért vagy szimulált jeleinket szeretnénk
időtartomány helyett frekvenciatartományban szeretnénk megvizsgálni. Ehhez a numerikus analízisből ismeretes
Diszkrét Fourier Transzformáció (DFT) nyújthat nekünk segítséget. Ezt az algoritmust az esetek túlnyomó
többségében az ún. gyors Fourier-transzformációval valósítják meg. Az algoritmust az angol Fast Fourier
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33. ábra. Kurzorok és jelmagyarázatok elhelyezése az ábrákon

Transform-nak, vagy röviden FFT-nek rövidítve használja, így ennek köszönhető, hogy a szaknyelvben a DFT
és FFT fogalma összeforrt, és a mérnökök gyakorlatilag ugyanazt értik alattuk.

Az LTspiceban FFT analízis végzésére időtartománybeli szimulációt kell végezzünk a .tran direktíva fel-
használásával. Ennek eredményeként előállnak a vizsgálható jeleink, pontosabban azok mintái, a szimuláció
diszkrét időlépésenként számítja ki a jeleinket. Az FFT analízis elvégzéséhez a hullámforma megjelenítő ab-
lakban kell a (Jobb egérgomb > View > FFT) opciót kiválasztanunk. Ekkor egy felugró ablakban
meg kell adnunk az FFT-vel transzformálódó jeleinket. Ezen kívül ebben az ablakban tudjuk beállítani az FFT
során felhasznált minták számát, mely alapértelmezetten a tranziens szimuláció összes időlépését tartalmazza.
Ezután, ha több jelet transzformáltunk, úgy ki kell választanunk, hogy ezen jelek közül melyiket szeretnénk
megjeleníteni. Ezután egy újabb felugró ablakban már láthatóvá is válik az ábrázolt jelek spektrális tartalma.

A folyamat illusztrálása érdekében figyeljük meg a 34. ábra kapcsolását. A kapcsolás a bemeneti 10 kHz-
es bemeneti jelet egy 100 kHz-es vivővel szorozza össze, felhasználva a 3. fejezetben ismertetett viselkedési
forrásokat. A szorzás eredményeként előáll egy két oldalsávos, nem elnyomott vivővel rendelkező, analóg ampli-
túdómodulált jel (AM-DSB/NSC). A sémán szereplő analóg szorzásból következő moduláció megértéséhez végig
tudjuk követni a 10. egyenleteket, melyek az általános, m modulációs mélységgel rendelkező AM-DSB jel előál-
lítását tükrözik. A trigonometrikus azonosságokat felhasználva szét tudjuk bontani a cos függvények szorzatát
egy összeg és egy különbségi frekvenciakomponensre.

(1 +m cos(ωst)) cos(ωct) = cos(ωct) +m cos(ωst) cos(ωct)

= cos(ωct) +
m

2
cos((ωs + ωc)t) +

m

2
cos((ωs − ωc)t)

(10)

34. ábra. Amplitúdómodulációt megvalósító kapcsolás

Az modulációs eljárásra jellemző spektrumot megjelenítve az előbb említett FFT algoritmussal látható lesz
a jellemző spektrális kép. A 35. ábrán láthatjuk szétszedve különböző ábrázolási síkokra a bemeneti 10 kHz-
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es jelünket, a 100 kHz-es vivőjelünket és a kettő szorzatából előálló amplitúdómodulált jelünk kétoldalsávos
spektrumát.

35. ábra. Amplitúdómodulált jel spektruma

Annak érdekében, hogy csökkentsük a numerikus számítás során a jeleinkre szuperponálódó nagyfrekven-
ciás zajokat, úgy érdemes a sémán elhelyezni egy .options direktívát melyben a szimuláció során alkalmazott
pontosságot emeljük meg. Alapértelmezés szerint az LTspice a számítások során egyszeres pontossággal számol
(single precision) vagyis a számok ábrázolására a C programozási nyelvből ismert float típust használja. A
numdgt érték 6-nál nagyobbra állítása esetén a program áttér double típusú számábrázolásra.

.options numdgt=7

Ahhoz, hogy az ábrázolt spektrumban a spektrális csúcsok jól kivehetőek legyenek, és ne kenődjenek el a
DFT algoritmus ablakozása miatt15, célszerű a szimulációs időt úgy megválasztani, hogy több periódust öleljen
fel, ezzel csökkentve az ún. spektrális szivárgást az ábrázolt spektrumokban.

Utolsó optimalizációs lehetőségként még megemlítjük, hogy alapértelmezés szerint az LTspice az időtarto-
mánybeli szimuláció eredményeit csak tömörítve menti el, ennek következtében az FFT analízis során különböző
torzítások léphetnek fel. Ez a tömörítés kikapcsolható a (Tools > Settings > Compression > Enable 1st
(2nd) Order Compression) opciók kikapcsolásával. A 35. ábrát az előző bekezdésekben említett beállítások
együttes használatával értük el. Ezen beállítások nélkül az olvasó a miénktől eltérő eredményt fog kapni.

6.3. Mérések elvégzése és a .measure direktíva

A fejezet elején megismerkedtünk a hullámformák vizualizációjával valamint a kurzorok használatával. Kurzo-
rok segítségével a hullámformákról könnyedén tudtunk számértékeket leolvasni a független változó (vízszintes
tengely) különböző értékei mellett. A gyakorlatban azonban előfordul, hogy a szimulációk végeztével csupán
csak néhány specifikus pontban szeretnénk leolvasni a hullámformákban tárolt információt. Ilyen esetekben
lehet hasznos számunkra a .measure vagy .meas16 direktíva. Ebben a szakaszban megismertetjük az olvasót
az automatizált mérések néhány gyakrabban használt esetével.

15A DFT algoritmus használatát felfoghatjuk úgy, mint egy folytonos idejű jel és egy ablakfüggvény szorzatának
Fourier-transzformáltját. Ebben az esetben az ablakfüggvényünk egy négyszögfüggvény, melynek szélessége megegyezik
a szimulációs időnk hosszával. Mivel az időtartománybeli szorzás azonos a frekvenciatartománybeli konvolúcióval, így a
spektrumunkban a négyszögablakra jellemző sin(x)/x-es spektrumot fogjuk látni a bementi jelünk frekvenciáival eltol-
va. Mivel a kezdeti jelünk mintavételezett volt, így a végleges DFT spektrumot a folytonos és ablakozott spektrumok
mintáiból is elő tudjuk állítani.

16Az LTspice mind a két változatot elfogadja
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A measure direktívával elvégzett méréseknek alapvetően két változata létezik, az egyik változat esetében a
mérés egy adott pontra vonatkozik, míg a másik változat esetén pedig a mérés egy intervallum fölött értelmezett.
Először a pontok felett értelmezett változatot tárgyaljuk. A direktíva általános szintaktikájának tárgyalása
helyett, inkább néhány példán keresztül illusztráljuk az elvégzett méréseket.

.measure TRAN val1 FIND V(out) AT 5m

.measure TRAN val2 FIND V(out)*I(Vout) WHEN V(x)=3*V(y)

.measure TRAN val3 DERIV I(out) AT 2m

.measure TRAN val4 PARAM 3*val1/val2

A direktívákban szereplő TRAN kulcsszó megadja, hogy az adott mérés mely szimulációs fajta esetén
értékelődjön ki. Lehetséges értékei aAC, DC, OP, TRAN, TF és NOISE. A val1-val4 a mérési eredmények
azonosítására szolgáló címkék lesznek, vagyis az első mérés eredményét a val1 név alatt fogjuk megtalálni a
későbbiekben. Ezt követően meg kell adni, hogy milyen mérést szeretnénk elvégezni. A lehetséges értékek
a FIND, DERIV és PARAM. A FIND paranccsal egy meghatározott mérési pontban tudjuk leolvasni a
vizsgált jel értékét. A mérési pontot meghatározhatjuk a független változó egy adott értékével, ekkor a AT
parancsot használjuk, vagypedig egy adott feltétel teljesülése esetén, mely esetben a WHEN paranccsal adjuk
meg a feltételt. Ennek megfelelően az első mérési eredmény az out csomópont feszültségét olvassa le a tranziens
szimuláció 5. ms-ban. Val2 értékben pedig az out csomópont feszültsége lesz eltárolva, amikor az x csomópont
feszültsége az y csomópont feszültségének háromszorosával egyezik meg.

A DERIV paranccsal a jel megváltozásának pillanatértékét olvashatjuk le. Tranziensz szimuláció esetén
ez egybeesik az idő szerinti deriváltal. A parancs használata mellett itt is kétféleképpen adhatjuk meg a mérési
pont feltételét az AT és a WHEN kulcsszavakkal.

Az utolsó lehetőség a pontok felett értelmezett mérésekre a PARAM kulcsszó használata, mellyel a korábbi
méréseink értékeit tudjuk továbbszámolni. Ez a fajta mérés lehetőséget ad, hogy összetettebb mennyiségeket is
meghatározzunk. Ennek a mérésnek egy lehetséges felhasználási módja a kapcsolóüzemű tápegységek hatásfo-
kának számítása, hiszen ekkor meg kell mérjük a be- és kimeneti teljesítményeket, valamely mérési pontokban
és ezek hányadosából tudjuk meghatározni az energiaátalakítás hatásfokát.

Az intervallumok felett értelmezett mérésekkel alapvetően más típusú mennyiségeket tudunk kinyerni a
szimulációinkból, így a továbbiakban ezekkel foglalkozunk.

.measure TRAN Uavg AVG V(out)

A fenti direktívával meg tudjuk határozni az out csomópont feszültségének átlagértékét az AVG kulcs-
szóval, valamint a mérés eredményét eltároljuk az Uavg változóba. Az átlagon kívül lehetőségünk van még
maximum, minimum, csúcstól-csúcsig érték, RMS középérték és határozott integrál számítására is. Ezekhez fel
kell használjuk a MAX, MIN, PP, RMS és INTEG kulcsszavakat. Hasonlóan a pontok felett értelmezett
mérésekhez, itt is lehetőségünk van extra feltételek megadására, melyekkel a méréseinket tovább specifikálhat-
juk. Egy ilyen specifikus mérésre láthatunk egy példát a következő direktívánál. A direktíva az out csomópont
feszültség idő szerinti integrálját számolja ki. Az integrálás alsó határaként az az időpont van meghatározva,
ahol az in csomópont a 2 V-os értéket másodjára éri el egy felfutó éllel. Ha lefutó élre szeretnénk indítani az
integrálást, úgy a RISE helyett a FALL parancsot kell használjuk. Az integrálás felső határát a TARG pa-
ranccsal tudjuk megadni, ahol példánkban az in csomópont 6 V-os küszöbérték 5. kereszteződéséig számolunk.
Ekkor nem specifikáltuk, hogy a küszöbértéket felfutó vagy lefutó ágon érjük el.

.measure TRAN Uint INTEG V(out) TRIG V(in)=2 RISE=2
TARG V(in)=6 CROSS=5

A mérési direktívák szerkesztésének és a szintaktikák tanulásának könnyítése végett lehetőségünk van a
parancsok szerkesztésére egy grafikus felületen kersztül is. Ehhez el kell készítenünk egy kezdetleges direktívát,
pl. a .meas direktíva, amit ezután elhelyezünk a sémán. A már lehelyezett direktívára jobb egérgombbal
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kattintva megnyílik a grafikus szerkesztőfelület, ahol könyebben tudjuk megadni méréseink specifikációját. A
grafikus szerkesztőfelület a 36. ábrán látható. A grafikus szerkesztő nagy előnye emellett, hogy lehetőségünk
van a szimulációnk lefuttatása után letesztelni a mérési direktívánk eredményét a bal alsó sarokban található
TEST gomb segítségével!

Előfordulhat, hogy az automatizált méréseink nem adják vissza a kívánt eredményt. Ebben az esetben egy
lehetséges megoldás lehet a szimulált pontok számának növelése pl. tranziens szimuláció esetén a maximális
időlépés csökkentésével. Ezzel megnövelve az esélyt, hogy a mérések kiértékelésekor a szimulált adatpontok
beleesnek a direktíva toleranciasávjába.

36. ábra. Mérési direktívák grafikus szerkesztőfelülete

Áramköri paraméterek változtatása esetén szükséges lehet a paraméterek hatását vizsgálni a mérési eredmé-
nyeken. A korábbiakban csak a hullámformákból egyszerűen kinyerhető információk ábrázolásával foglalkoztunk,
azonban az LTspice-ban lehetőségünk van a mérési eredmények grafikus megjelenítésére is. Ehhez a szimulációk
futtatása után meg kell nyitnunk a kimeneti log fájlt (View > SPICE Output Log) vagy a CTRL + L
gyorsgomb használatával. A log fájlban jobb egérgombbal klikkelve és kiválasztva a Plot .step’ed .meas data
opciót egy új hullámformamegjelenítő ablak ugrik fel. Ebben az ablakban jobb egérgomb Add Traces vagy a
A gyorsgombot lenyomva kiválaszthatjuk, hogy a mérési eredményeink közül melyiket szeretnénk megjeleníteni
az ábrán.

Az így előálló másodlagos hullámforma megjelenítő ablakban a fejezet elején leírtakkal azonosan tudjuk
módosítani az ábrázolt jeleinket. Kiterjed ez mind a tengelyek módosítására, a független változó megváltoz-
tatására és a jelek közötti matematikai műveletekre is. Az egyetlen kitétel, hogy a másodlagos hullámforma
megjelenítőben csak és kizárólag a mérési eredményeink jelennek meg mint jelek, az elsődleges jeleinket (áramok
és feszültségek) nem tudjuk felhasználni.

7. Modellfájlok felhasználása

Szimulációs modellezés során előfordul, hogy a modellezni kívánt alkatrész modellparamétereit nem tudjuk saját
magunk megadni (esetleges mérések alapján), vagy nem tudunk az általunk használt szoftver könyvtárában
alkalmas modellfájlt találni. Ekkor rá vagyunk kényszerülve, hogy ún. harmadik féltől származó modelleket
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használjunk. Ezeket a modelleket egy külső forrásból kell beszerezzük, vagyis meg kell őket vásárolnunk, vagy
ingyenes és szabad hozzáférésű modelleket kell használunk.

Ebben a fejezetben bemutatjuk, hogyan adhatunk hozzá modellfájlokat az általunk készített modellekhez
és hogyan tudjuk felhasználni az általunk készített kapcsolásokat alkatrészek és modulok modellezésére.

7.1. Modellfájlok importálása

Az LTspice lehetőséget biztosít harmadik féltől származó modellek felhasználására és szimulálására. Ehhez leg-
egyszerűbb esetben csak a szükséges modellfájlt kell hozzáadjuk a kapcsolási sémához. Ezt kétféleképpen tudjuk
megtenni. Egyrészt bemásolhatjuk a sémára modellfájl teljes tartalmát, vagy egy direktíva hozzáadásával. Az
első esetben a sémán elérhetővé válik a modellezet komponens leírása (általában egy netlista formájában), így a
sémát olvasó mérnök mélyebb betekintést nyerhet a kapcsolás működésébe. Abban az esetben, ha a modellfájl
számunkra nem képvisel értékes hozzáadott információt, úgy célszerű a modellfájlt egy külső fájlból hozzáadni
a sémánkhoz. Erre szolgál az .include direktíva, mellyel a megadott szöveges fájl tartalma teljes egészében be-
másolódik a szimulált séma netlistájához a szimuláció megkezdése előtt. Ezekre a lehetőségekre látunk példákat
a 37. ábrán.

37. ábra. Külső modellek megadásának két lehetséges módja

a 37. ábrán egy egyutas egyenirányító kapcsolás két példánya figyelhető meg. A fölső kapcsolásban az
egyenirányító dióda típusa (modellje) Dtext. Ennek a diódatípusnak a működését egy SPICE Diódamodell írja
le. A modell pontos mőködésének megadásához rengeteg paraméter numerikus értékét meg kell adnunk. Ezen
paraméterek a kapcsolás alatt látható .model direktíva meghívásával vannak specifikálva. A direktíva után
megadjuk az általunk modellezett komponens nevét (ebben az esetben a Dtext), mely egy spice diódamodell és
specifikáljuk az alapértelmezett dióda paramétereitől eltérő értékeket egy kulcs-érték pár szintaktikával.

A diódamodell alternatív megadási módja az .include direktíva használata. Ebben az esetben meg kell
adnunk a szöveges fájl nevét (ebben az esetben Dinc.sub) és el kell helyeznünk a szükséges fájlt a sémával
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azonos könyvtárba (vagy az LTspice alapértelmezetten keresett könyvtárainak valamelyikébe). A .sub fájl
lényegi tartalma ezen szimuláció során teljesen azonos a .model direktívánál használtakkal.

Mind a két esetben a szimulációk gond nélkül lefutnak és szépen mutatják a terhelt egyutas egyenirányító
jellegzetes hullámformáit, azonban a sémán gyökeresen eltérő módon jelennek meg. A fenti kapcsolás mélyebb
betekintést enged a sémát néző mérnök számára a szimulációs modell beállításaiba és az azokból fakadó hibale-
hetőségekbe, míg az utóbbi egy hierarchikusabb módon kiemeli a lényegi részt és elfedi a kevésbé lényegeseket.

Fontos megjegyezni, hogy bizonyos alkatrészgyártó cégek az álltaluk gyártott alkatrészek SPICE modelljeit
csak titkosított formában teszik publikusan elérhetőve. Ez a leírásmód többnyire gépi kódból álló szöveges fájl
formájában jelenik meg. Ennek következtében a titkosított alkatrészmodellek esetében az .include direktíva
használata javasolt, hiszen semmilyen többletinformációt nem ad hozzá a modellfájl a kapcsolási sémánkhoz!

7.2. Eszközkönyvtárak importálása

Egyes alkatrészgyártó cégek a szimulációs modellfájlokat csoportosítják a modellezett komponens szerint ún.
alkatrészkönyvtárakba. Ezekben az alkatrészkönyvtárakban többnyire azonos célú vagy viselkedésű alkatré-
szek SPICE modelljeit adják meg egy aláramkör (.subckt direktívát felhasználva) formájában, majd ennek az
aláramkörnek a különböző paraméterezéssel ellátott példányait sorolják fel, szintén aláramköri modellek fel-
használásával. A módszer előnye, hogy az alkatrészek viselkedését modellező áramköri kapcsolást csak egy
példányban kell összeállítani és a különbőző alkatrészek modelljei ebből leszármaztathatók a modell paraméte-
reinek módosításával.

Alkatrészkönyvtárak importálásához lényegében az .include direktívával azonos módon kell eljárnunk. A
sémán el kell helyeznünk egy .lib direktíva utasítást mely után megadjuk az importálni kívánt alkatrészkönyv-
tár fájlnevét, kiterjesztéssel együtt! Az importált fájl elérési útjához fűződő gondolatok azonosak az include
direktívánál ismertetekkel.

7.3. Eszközkönyvtárak készítése

Ebben a szakaszban bemutatjuk, hogyan készíthetünk saját alkatrészkönyvtárat egy áramköri komponens mo-
dellezésére. A folyamatot egy összetetteb kapcsolás példáján vezetjük végig, azonban a kapcsolás működésére
és a modellezett jelenségek leírására nem térünk ki17.

A modellezés első lépéseként a paraméterekkel ellátott áramköri modellt kell megalkossuk melyből az alkat-
részkönyvtárat a későbbiekben származtatjuk majd. Ennek az áramköri leírásnak a megadása történhet rögtön
a netlistafájl megadásával, azonban annak átláthatósága és az esetleges hibák elkövetésének veszélye miatt, csak
indokolt esetben javasoljuk az olvasók számára a használatát! Az áramköri leírás megadásának egyszerűbb és
nyomonkövethetőbb formája a grafikus sémaszerkesztő használata. A sémaszerkesztőn a 3. fejezetben ismer-
tetett módon meg tudjuk rajzolni az áramköri modellünket. A példánk során a 38. ábra kapcsolását fogjuk
felhasználni.

A séma megrajzolása után ki kell nyernünk a netlista szerinti leírást. Ehhez a (View > SPICE Netlist)
opciót kell kiválasztanunk. Ekkor egy felugró ablakban megjelenik a sémával ekvivalens netlista alapú áramköri
leírásunk, ahogy azt a 39. ábrán láthatjuk is. Ebben a leírásban az egyes áramköri részek tematikusan rende-
zetlen formában lettek rögzítve, így célszerű lehet azokat átcsoportosítani és kommentekkel ellátni, ahogy az
a 40. ábrán is látható. Mint már említettük a modellezett komponenseket ún. aláramkörök formájában tudjuk
hozzáadni az LTspice-hoz. Ehhez nyissunk meg egy új szöveges fájlt és adjuk hozzá a 40. ábra tartalmát.

A .subckt direktíva után az aláramkörünk nevét kell megadjuk (SolarCell) majd a külső áramköri összeköt-
tetések neveit. Fontos megjegyezni, hogy netlisták alkalmazásánál az aláramkör elektromos összeköttetések nem
a vezetékek nevei alapján történnek (ahogy az a hierarchikus kapcsolások esetében történt), hanem a netlistán
szereplő csomópontok sorrendje alapján. Így példánkban az aláramkör példányosításánál a első vezetékcimke
lesz összekötve a 38. ábra kapcsolásának P kivezetésével és így tovább!

17A téma iránt érdeklődő hallgató számára javasoljuk a Zöld villamosenergia-termelés című tárgyat a további részletek
megismerése érdekében!
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38. ábra. Összetett fotovoltaikus cella áramköri modellje

39. ábra. Aláramkör netlista reprezentációja 40. ábra. Alkatrészkönyvtár netlistája

.subckt SolarCell P N Illumination Pdiss

Ezután megadjuk az aláramköri részben szereplő áramköri komponenseket és az azokat összekötő vezeté-
keket. Ezt célszerű a grafikus felületen megszerkesztett séma netlistájából egyszerűen kimásolni egy tematikus
sorrendben. A tematizálást segíthetjük kommentek házzáadásával is! A netlista fájlban minden sor ami a *
karakterrel kezdődik kommentként lesz értelmezve. Az áramköri leírás végét az ends direktíva jelzi.

Ezek után hozzá tudjuk adni az alkatrészkönyvtárunkhoz a példányosított és paraméterekkel ellátott konk-
rét szimulációs modelljeinket. Ehhez egy új sorban létre kell hozzunk egy egyedi névvel rendelkező aláramkört
(.subckt direktíva), példányosítanunk kell benne a generikus áramköri leírásunkat és meg kell adjuk a paramé-
tereit. A + jelet felhasználva az előző sor tartalmát egészíthetjük ki, mintha csak folytattuk volna azt. Ennek
használata lehetővé teszi a hosszú sorok elkerülését, valamint lehetővé teszi a netlista fájlok tartalmának több
sorba rendezését. Netlista fájlok esetében minden áramköri komponens egy-egy sorban foglalhat csak helyet +
jel használata nélkül.

.subckt cell1 1 2 3 4
X1 1 2 3 4 SolarCell w={w} l={l} ms={ms} mp={mp} alpha=0.3
+ Is=1e-9 n=1 bdV=10 bdI=1 Rs=1m Rp=1k
.ends

Ebben az esetben a specifikus komponensünk a cell1 nevet kapta és a kivezetései az 1, 2, 3, 4 cimkéket
kapták. Ezen áramköri részen belül létrehozzuk az aláramkörünk egy példányát. A komponens egyedi azo-
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nosítója az X1-es, melyben a X prefixum jelzi, hogy netlistával modellezett aláramkörről van szó és nem egy
hierarchikus blokkról. Ezután meg kell adjuk az X1-es komponens leírását (ez a generikus SolarCell modell) és
a paramétereket egymás mellé felsorolva, kulcs-érték párok szintaktika megadásával. Alternatív módon ezeket
megadhatnánk a cell1 netlistájában a .param direktívát használva is. A w, l, ms és mp paraméterek esetében
alkalmaznunk kell a -t, hiszen ezeket a paramétereket a szimbólum fogja szolgáltatni nekünk egy hierarhikus
réteggel feljeb!

Ezzel el is készítettük az alkatrészkönyvtárunkat és hozzá is adtunk egy paraméterekkel specifikált kompo-
nenst is, azonban jelenlegi állapotában az alkatrészkönyvtár csak netlista formájában adható hozzá sémákhoz.
A könnyebb kezelhetőség érdekében készíthetünk hozzá egy szimbólumot, amit sémákon lehelyezve elérjük az
alkatrészkönyvtárat. Új szimbólum hozzáadásához nyissunk meg a szimbólumszerkesztőt (File > New
Symbol) és rajzoljuk meg aláramkörünk szimbólumát a 41. ábra szerint.

41. ábra. Fotovoltaikus cellát reprezentáló szimbólum

Az áramköri pin-ek megadásánál ügyeljünk azok sorrendjére, hiszen az áramköri összeköttetések ez a sorrend
alapján kerül megvalósításra! Ennek megfelelően a kivezetéseket állítsuk be a .subckt direktívának megfelelő
sorrendbe! Ezek után hozzá tudunk adni a szimbólumunkhoz ún. attribútumokat, melyek a szimbólum para-
méterezését segítik és a sémán is láthatóvá tehetők. Ezzel lehetőségünk van a fontosabb paramétereket a séma
szerkesztője számára is elérhető tegyük. Az attribútumok beállításához a (Jobb egérgomb > Attributes
> Edit Attributes) vagy a CTRL + A gyorsgombot kell megnyomjuk.

Az attribútomok közül mindenképpen át kell állítsuk a szimbólum típusát Cell-re, ezzel jelezve az LT-
spicenak, hogy ne keressen a szimbólumhoz tartozó hierarchikus blokkot, csak egy netlistát. A következőkben
beállíthatjuk a sémáról elérhető paramétereinket. A paramétereket melyeket aValue, Value2, SpiceLine vagy
SpiceLine2 mezőkbe írunk mind meg tudjuk jeleníteni a sémán, valamint módosítani is tudjuk őket onnan!
A paramétereket tetszőlegesen elhelyezhetjük ezekben a mezőkben, hiszen a sorrendjük csak azt befolyásolja,
hogy a szimulációs netlistába milyen sorrendbe fognak bekerülni. Ennek megfelelően a Value és Value2 me-
zők tartalmát feltölthetjük a 41. ábrának megfelelően. A Description mezőben megadhatjuk a szimbólum
által reprezentált kapcsolás rövid leírását. A legutolsó fontos paraméter a ModelFile sor. Ezen soron tudjuk
megadni a szimbólum által reprezentált aláramkört leíró könyvtárat. Ennek megfelelően állítsuk be ezt a sort
solar_cell.lib-re. Ennek hatására a szimbólum sémára való lehelyezésével meghatározzuk az alkatrészkönyv-
tárat tartalmazó fájlnevet is, így nem lesz szükséges további .include direktívák elhelyezése a séma felületén!
A beállított attribútumok megjelenítéséhez a (Jobb egérgomb > Attributes > Attribute window)
vagy a CTRL + W gyorsgombot kell megnyomjuk. Ekkor egy felugró ablakban ki tudjuk választani a sémán
elhelyezendő attribútumunkat és azt leokézva le tudjuk helyezni azt a sémára.

A szimbólumon elhelyezett attribútomok között megtalálható a w, l, ms és mp változók. Ezeket a változó-
kat megjelenítjük a sémán, így az aláramkör példányosítása után is könnyen szerkeszthetők lesznek. Azonban a
végső netlista összeállításakor ezeket a változókat tovább kell küldenünk a cell1 példányon belül példányosított
SolarCell áramkörnek. Ezt a célt szolgálják a w = w és hasonló sorok. Vagyis a SolarCell aláramkör w paramé-
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terének adjuk a szimbólum w paraméterének értékét! Ebben az esetben a változók azonos neve megnehezíti az
értelmezést, de a dolog lényegi része csak és kizárólag numerikus értékek továbbküldése az alacsonyabb szintű
aláramköröknek!

Az így elkészített alkatrészkönyvtárat és szimbólumot már csak hozzá kell adnunk az LTspice megfelelő
mappáihoz, hogy az LTspice-t elindítva hozzájuk is férjünk. Ehhez másoljuk át a solar_cell.lib fájlunkat
a C:\Users\USERNAME\AppData\Local\LTspice\lib\sub mappába. Fontos, hogy ne a C:\Prog-
ram Files\ADI\LTspice mappába rakjuk! Az elkészített szimbólum .asy fájlját pedig másoljuk át a
C:\Users\USERNAME\AppData\Local\LTspice\lib\sym mappába, vagy ebben a mappában létre is
hozhatunk egy új mappát a tematikus rendezés érdekében. Ha almappába másoljuk a szimbólum fájlját úgy a
sémához való hozzáadáskor is az azonos nevű almappában kell majd keressük a szimbólumunkat.

Az LTspice újraindítása után az így elkészített alkatrészkönyvtárunkat már el fogjuk tudni érni a hozzáadott
szimbólumunkon keresztül és példányosítani is fogjuk tudni a sémaszerkesztőben. Egyetlen fontos paramétert
azonban nem állítottunk eddig még be. Eddig a pontig csak az alkatrészkönyvtárat specifikáltuk (a ModelFile sor
segítségével) azonban nem montuk meg az LTspice-nak, hogy ebből a könyvtárból melyik alkatrészt szeretnénk
használni. A pontos alkatrész kiválasztásához a példányosított szimbólum SPICE Model sorába be kell írnunk
a használni kívánt alkatrészünk nevét, mely esetünkben cell1! Ezáltal szimulálhatóvá vált az alkatrészünk
számos absztrakciós rétegen keresztül!

8. Összefoglalás

Ezzel végére értünk az LTspice alapvető szintű müködésének és az általa nyújtott szimulációs és modellezési
lehetőségeinek bemutatásának. Ugyan a segédlet nem tért ki a szoftver minden részletére, de jelen segédlet
elkészítésekor ügyeltünk a lehetőségek széleskörű bemutatására és az egyes szimulációk illusztrálására példakap-
csolásokon keresztül. Reméljük jelen segédlet hiánypótló jelleggel elősegíti a magyarországi egyetemi hallgatók
és szimulációs mérnökök eligazodását az LTspice mélyebb világában és teszi ezt magyar nyelven! A segédletben
illusztrált példakapcsolások és egyéb segédfájlok megtalálhatók jelen PDF dokumentumhoz csatolva, ezzel is
megkönnyítve azok elérését és a szükséges fájlok csomagként történő kezelését! A program méllyebb megérté-
séhez javasoljuk az Olvasónak a súgófájl használatát, melyet az F1 gyorsgombbal tud előhívni!

Jelen segédlet csak egy előzetes és nem végleges változat, emiatt kérjük az olvasókat az esetleges elírások és
hibák jélzésére a szerzőknél.
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A. Használt gyorsgombok listája

Az LTspice könnyebb és gyorsabb használhatósága érdekében célszerű röviden áttekinteni az LTspice alapértel-
mezett és általunk használt gyorsgombjait. Az egyes gyorsgombok az LTspice-on belül a különböző szerkesz-
tőkörnyezetekben eltérőek lehetnek, hiszen a különböző szerkesztőkörnyezetekben más és más funkcionalitást
használunk gyakrabban. A program 4 szerkesztőkörnyezetet különböztet meg, ezek a séma, szimbólum, hul-
lámforma és netlista. Ezekben a környezetekben definiált gyorsgombokat a programon belül szerkeszteni
nem lehet, azonban le lehet tölteni őket egy szöveges fájlba, azon belül módosítani, majd ezt a szöveges fájlt
vissza lehet tölteni az LTspice-ba. A meglévő gyorsgombok a (Tools > Settings > Drafting options
> Keyboard shortcuts) menüből érhetők el illetve itt van lehetőségünk új gyorsgombok hozzáadására
egy szöveges fájlból. A következő táblázatban összefoglaljuk a fontosabb gyorsgombokat, fókuszálva a séma
szerkesztőre és a hullámforma megjelenítőre.

Séma szerkesztő Hullámforma megjelenítő

Új komponens hozzáadása P Függőleges igazítás CTRL+Y
Vezeték rajzolása W Rács megjelenítése CTRL+G
Vezetékcimke hozzáadása N Hullámforma hozzáadása A
Törlés DEL Törlés DEL
Másolás18 CTRL+C Ábrázolási sík hozzáadása

felül
P

Mozgatás19 M Ábrázolási sík hozzáadása
alul

B

Húzás20 S Kurzorcimke hozzáadása L
SPICE direktíva . Szöveg hozzáadása T
Föld szimbólum G Vonal rajzolása I
Ellenállás R Ábrajelölők másolása CTRL+C
Kapacitás C Ábrajelölők mozgatása M
Induktivitás L Ábrajelölők húzása S
Dióda D
Feszültségforrás V
Forgatás CTRL+R
Tükrözés CTRL+E
Szimuláció indítása SHIFT+R
Szimuláció leállítása SHIFT+H
SPECE log fájl megnyitás CTRL+L
Egész séma látótérbe helyezése SPACE

3. táblázat. Gyakran használt gyorsgombok listája

18A kijelölt áramköri részt megkettőzi
19A kijelölt áramköri részt mozgatja, függetlenül az összeköttetésektől
20A kijelölt áramköri részt húzza, megtartva az összeköttetéseket
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B. PDF-he csatolt fájlok listája

Fájlnév Fájl leírása
UbuntuInstall.sh Wine telepítő script Ubuntu 22.04-hez
shortcuts.txt Importálható gyorsgombok beállítási fájlja
audio_preamp_example.asc Audió előerősítő tesztkapcsolása
audio_preamp.asc Audió előerősítő belső kapcsolási rajza
audio_preamp.asy Audió előerősítő szimbóluma
bjt.asc BJT karakterisztika meghatározásához használt kapcsolás
paramExample.asc Parametrikus kaszkád feszültségosztó
mcExample.asc Monte Carlo szimulációs példakapcsolás
noise.asc Zajszimuláció kapcsolási rajza
voltage_divider.asc Feszültségosztó kapcsolási rajza
efgh_sources.asc Vezérelt források
Bsources.asc Tetszőleges viselkedésű források
antennaImpedance.sub Antenna impadanciamenetét leíró modell
ArbitraryImpedance.asy Tetszőleges impedanciamenetet modellező szimbólum
netExample.asc Tesztkapcsolás kétpólus és kétkapu paraméterek számításához.
Dinc.sub Diódamodell include direktíva használatához
include.asc Modellfájlok importálását bemutató séma
Complex_pv_model.asc Összetett fotovoltaikus modell
solar_cell.lib Fotovoltaikus cellák könyvtára
Solar_cell.asy Fotovoltaikus cella szimbúluma

4. táblázat. Csatolt fájlok listája és leírása
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#!/bin/bash
# Wine installization script
# Created by David Deak 2024 January

sudo dpkg --add-architecture i386
sudo mkdir -pm755 /etc/apt/keyrings
sudo wget -O /etc/apt/keyrings/winehq-archive.key https://dl.winehq.org/wine-builds/winehq.key
sudo wget -NP /etc/apt/sources.list.d/ https://dl.winehq.org/wine-builds/ubuntu/dists/jammy/winehq-jammy.sources
sudo apt-get update
sudo apt-get upgrade
sudo apt-get install winehq-stable
cd Downloads
wget https://www.skin-soft.co.uk/files/msstyles/gelxp2.msstyles
wget https://ltspice.analog.com/software/LTspice64.msi
wine msiexec /i LTspice64.msi 
cd ..
echo "# LTspice" >> ~/.bash_aliases
echo 'alias ltspice="wine ~/.wine/drive_c/Program\ Files/ADI/LTspice/LTspice.exe&"' >> ~/.bash_aliases
winecfg



[SchKeyBoardShortCut]

Configure_Analysis=A

Run_Simulation=Alt+R

Halt_Simulation=Alt+S

View_SPICE_Error_Log=Ctrl+L

Zoom_Area=Z

Zoom_Back=Shift+Z

Zoom_to_Fit=Space

Draw_Wire_Mode=W

Place_Ground=G

Place_Voltage_Source=V

Place_Resistor=R

Place_Capacitor=C

Place_Inductor=L

Place_Diode=D

Place_Component=P

Place_Netname=N

Place_Comment_Text=T

Place_SPICE_Directive=.

Move_Mode=M

Drag_Mode=S

Rotate=Ctrl+R

Mirror=Ctrl+E

Delete_Mode=Backspace

Duplicate_Mode=Ctrl+C

Undo=Ctrl+Z

Redo=Ctrl+Shift+Z

Draw_Lines=(none)

Draw_Rectangles=(none)

Draw_Circles=(none)

Draw_Arcs=(none)

Schematic_Grid=Ctrl+G

Unconn_Pin_Marks=Ctrl+U

Text_Anchor_Marks=Ctrl+A

Reset_T_0=0

Place_BUS_Tap=B

Place_COM=Alt+G

[AsyKeyBoardShortCut]

Object_Anchors=O

Place_Pin=P

Delete_Mode=Backspace

Duplicate_Mode=Ctrl+C

Move_Mode=M

Drag_Mode=S

Undo=Ctrl+Z

Redo=Ctrl+Shift+Z

Place_Comment_Text=T

Draw_Lines=L

Draw_Rectangles=R

Draw_Arcs=A

Draw_Circles=C

Rotate=Ctrl+R

Mirror=Ctrl+E

Attribute_Editor=Ctrl+A

Attribute_Window=Ctrl+W

Zoom_Back=Shift+Z

Zoom_In=Z

Zoom_to_Fit=Space

Show_Pin_Table=(none)

[RawKeyBoardShortCut]

Zoom_to_Fit=Space

Zoom_Area=Z

Zoom_Back=Shift+Z

Vertically_Autorange=Ctrl+Y

Redraw_Window=F5

Toggle_Grid=Ctrl+G

Delete_Mode=Backspace

Add_Trace=A

Add_Pane=P

Add_Pane_Below=B

Move_Pane_Up=U

Move_Pane_Down=D

Undo=Ctrl+Z

Redo=Ctrl+Shift+Z

Run_Simulation=Alt+R

Halt_Simulation=Alt+S

Open_Plot_Settings_File=O

Reload_Plot_Settings_File=Ctrl+Space

Place_trace_cursor=C

Clear_all_cursors=Shift+C

Label_cursor_position=L

Place_text_on_the_plot=T

Draw_an_arrow_on_the_plot=(none)

Draw_a_line_on_the_plot=I

Draw_a_box_on_the_plot=R

Draw_a_circle_on_the_plot=(none)

Annotation_Line_Style/Color=(none)

Copy_Plot_Annotations=Ctrl+C

Move_Plot_Annotations=M

Drag_Plot_Annotations=S

Select_Steps=Shift+S

View_SPICE_Error_Log=Ctrl+L

[NetKeyBoardShortCut]

Goto_Line_Number=Ctrl+G

Run_Simulation=Alt+R

Halt_Simulation=Alt+S

Undo=Ctrl+Z

Redo=Ctrl+Shift+Z

View_SPICE_Error_Log=Ctrl+L




Version 4
SHEET 1 880 680
WIRE 384 -112 368 -112
WIRE 416 -112 384 -112
WIRE 368 -80 368 -112
WIRE 304 -16 80 -16
WIRE 480 -16 432 -16
WIRE 512 -16 480 -16
WIRE 80 16 80 -16
WIRE 512 16 512 -16
WIRE 368 80 368 48
WIRE -128 112 -144 112
WIRE -96 112 -128 112
WIRE 80 128 80 96
WIRE 80 128 -48 128
WIRE 512 128 512 96
WIRE 512 128 448 128
WIRE 560 128 512 128
WIRE 656 128 640 128
WIRE -144 144 -144 112
WIRE -48 144 -48 128
WIRE 80 160 80 128
WIRE 512 160 512 128
WIRE 656 176 656 128
WIRE 384 192 368 192
WIRE 416 192 384 192
WIRE 368 224 368 192
WIRE -144 240 -144 224
WIRE -48 240 -48 224
WIRE 80 288 80 240
WIRE 304 288 80 288
WIRE 480 288 432 288
WIRE 512 288 512 240
WIRE 512 288 480 288
WIRE 368 384 368 352
FLAG -48 240 0
FLAG 656 176 0
FLAG 368 80 0
FLAG 368 384 0
FLAG 384 192 Vdd
FLAG 384 -112 Vdd
FLAG -144 240 0
FLAG -128 112 Vdd
FLAG 480 -16 outp
FLAG 480 288 outn
FLAG 448 128 common
SYMBOL voltage -48 128 R0
WINDOW 123 0 0 Left 0
WINDOW 39 0 0 Left 0
SYMATTR InstName V1
SYMATTR Value 5
SYMBOL voltage 80 0 R0
WINDOW 123 24 124 Left 2
WINDOW 39 0 0 Left 0
SYMATTR Value2 AC 0.5
SYMATTR InstName V2
SYMATTR Value SINE(0 {amp/2} 1k)
SYMBOL voltage 80 144 R0
WINDOW 123 24 124 Left 2
WINDOW 39 0 0 Left 0
SYMATTR Value2 AC 0.5
SYMATTR InstName V3
SYMATTR Value SINE(0 {amp/2} 1k)
SYMBOL res 496 0 R0
SYMATTR InstName R1
SYMATTR Value 5k
SYMBOL res 496 144 R0
SYMATTR InstName R2
SYMATTR Value 5k
SYMBOL res 656 112 R90
WINDOW 0 0 56 VBottom 2
WINDOW 3 32 56 VTop 2
SYMATTR InstName R3
SYMATTR Value 100k
SYMBOL voltage -144 128 R0
WINDOW 123 0 0 Left 0
WINDOW 39 0 0 Left 0
SYMATTR InstName V4
SYMATTR Value 9
SYMBOL audio_preamp 368 -16 R0
SYMATTR InstName U1
SYMBOL audio_preamp 368 288 R0
SYMATTR InstName U2
TEXT -648 80 Left 2 !.tran 0 40m 30m 1u
TEXT -648 104 Left 2 !.four 1k 10 V(outp,outn)
TEXT -648 32 Left 2 !;.op
TEXT -648 56 Left 2 !;.ac dec 100 1 1meg
TEXT -648 256 Left 2 !;.step dec param amp 1m 100m 3
TEXT -648 184 Left 2 !.optionsnumdgt=12
TEXT -648 160 Left 2 !.options plotwinsize=0
TEXT -648 232 Left 2 !.param amp=100m
TEXT -648 312 Left 2 !.meas TRAN sig PP V(outp,outn)/2
TEXT -648 344 Left 2 !.meas TRAN common PP V(common)/2



Version 4
SHEET 1 880 680
WIRE 208 32 208 16
WIRE 112 128 48 128
WIRE 208 128 208 112
WIRE 208 128 112 128
WIRE 112 144 112 128
WIRE 48 160 48 128
WIRE 208 160 208 128
WIRE 240 160 208 160
WIRE 336 160 304 160
WIRE 208 208 208 160
WIRE -32 256 -64 256
WIRE 48 256 48 224
WIRE 48 256 32 256
WIRE 112 256 112 224
WIRE 112 256 48 256
WIRE 144 256 112 256
WIRE 208 320 208 304
FLAG 208 320 Vss
IOPIN 208 320 BiDir
FLAG 208 16 Vcc
IOPIN 208 16 BiDir
FLAG -64 256 In
IOPIN -64 256 In
FLAG 336 160 Out
IOPIN 336 160 Out
SYMBOL res 192 16 R0
SYMATTR InstName R1
SYMATTR Value 4k2
SYMBOL res 96 128 R0
SYMATTR InstName R2
SYMATTR Value 100k
SYMBOL npn 144 208 R0
SYMATTR InstName Q1
SYMATTR Value BC547B
SYMBOL cap 304 144 R90
WINDOW 0 0 32 VBottom 2
WINDOW 3 32 32 VTop 2
SYMATTR InstName C1
SYMATTR Value 15µ
SYMBOL cap 32 240 R90
WINDOW 0 0 32 VBottom 2
WINDOW 3 32 32 VTop 2
SYMATTR InstName C2
SYMATTR Value 15µ
SYMBOL cap 32 160 R0
SYMATTR InstName C3
SYMATTR Value 3n3



Version 4

SymbolType BLOCK

LINE Normal -6 -33 0 -33

LINE Normal -6 -5 -6 -33

LINE Normal 6 -5 -6 -5

LINE Normal 6 -33 6 -5

LINE Normal 0 -33 6 -33

LINE Normal 0 8 0 -5

LINE Normal -12 19 0 8

LINE Normal -12 35 -12 12

LINE Normal 0 40 -12 29

LINE Normal -23 24 -12 24

RECTANGLE Normal -64 -64 64 64

WINDOW 0 24 -72 Left 1

SYMATTR Description Single transistor audio preamp with decoupling capacitors

PIN -64 0 LEFT 8

PINATTR PinName In

PINATTR SpiceOrder 1

PIN 64 0 RIGHT 8

PINATTR PinName Out

PINATTR SpiceOrder 2

PIN 0 -64 TOP 4

PINATTR PinName Vcc

PINATTR SpiceOrder 3

PIN 0 64 BOTTOM 4

PINATTR PinName Vss

PINATTR SpiceOrder 4




Version 4
SHEET 1 880 680
WIRE 160 32 96 32
WIRE 224 32 160 32
WIRE 96 48 96 32
WIRE -16 96 -32 96
WIRE 32 96 -16 96
WIRE -32 128 -32 96
WIRE 224 128 224 32
WIRE -32 224 -32 208
WIRE 96 224 96 144
WIRE 96 224 -32 224
WIRE 224 224 224 208
WIRE 224 224 96 224
WIRE 96 240 96 224
FLAG 96 240 0
FLAG -16 96 Ube
FLAG 160 32 Uce
SYMBOL npn 32 48 R0
SYMATTR InstName Q1
SYMATTR Value BC547B
SYMBOL voltage 224 112 R0
WINDOW 123 0 0 Left 0
WINDOW 39 0 0 Left 0
SYMATTR InstName V2
SYMATTR Value 0
SYMBOL current -32 208 R180
WINDOW 0 24 80 Left 2
WINDOW 3 24 0 Left 2
WINDOW 123 0 0 Left 0
WINDOW 39 0 0 Left 0
SYMATTR InstName I1
SYMATTR Value 0
TEXT -136 280 Left 2 !.dc V2 0 1 1m I1 list 0 25u 75u 150u 200u



Version 4
SHEET 1 952 680
WIRE 32 96 -32 96
WIRE 144 96 112 96
WIRE 176 96 144 96
WIRE 304 96 256 96
WIRE -32 128 -32 96
WIRE 144 128 144 96
WIRE 304 128 304 96
WIRE -32 224 -32 208
WIRE 144 224 144 208
WIRE 304 224 304 208
FLAG 304 224 0
FLAG 144 224 0
FLAG -32 224 0
FLAG 144 96 mid
FLAG 304 96 out
SYMBOL voltage -32 112 R0
WINDOW 123 0 0 Left 0
WINDOW 39 0 0 Left 0
SYMATTR InstName V1
SYMATTR Value 1
SYMBOL res 128 80 R90
WINDOW 0 0 56 VBottom 2
WINDOW 3 32 56 VTop 2
SYMATTR InstName R1
SYMATTR Value {Rpar}
SYMBOL res 160 224 R180
WINDOW 0 36 76 Left 2
WINDOW 3 36 40 Left 2
SYMATTR InstName R2
SYMATTR Value {2*Rpar}
SYMBOL res 160 112 R270
WINDOW 0 32 56 VTop 2
WINDOW 3 0 56 VBottom 2
SYMATTR InstName R3
SYMATTR Value {Rpar2}
SYMBOL res 288 112 R0
SYMATTR InstName R4
SYMATTR Value {2*Rpar2}
TEXT -40 264 Left 2 !.op
TEXT -40 288 Left 2 !.param Rpar=table(x,0,1k,1,2k,2,5k,3,10k)
TEXT -40 312 Left 2 !.param Rpar2=table(x,0,100,1,200,2,500,3,1k)
TEXT -40 336 Left 2 !.step param x list 0 1 2 3
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SHEET 1 880 680
WIRE 80 32 -32 32
WIRE 240 32 160 32
WIRE 256 32 240 32
WIRE -32 96 -32 32
WIRE 256 96 256 32
WIRE -32 192 -32 176
WIRE 256 192 256 176
FLAG -32 192 0
FLAG 256 192 0
FLAG 240 32 out
SYMBOL voltage -32 80 R0
WINDOW 123 0 0 Left 0
WINDOW 39 0 0 Left 0
SYMATTR InstName V1
SYMATTR Value 2
SYMBOL res 64 48 R270
WINDOW 0 32 56 VTop 2
WINDOW 3 0 56 VBottom 2
SYMATTR InstName R1
SYMATTR Value {mc(Rpar,Rsigma)}
SYMBOL res 240 80 R0
SYMATTR InstName R2
SYMATTR Value {Rpar+gauss(Rsigma)}
TEXT 296 40 Left 2 !.param Rpar = 1k Rsigma = 100
TEXT 296 64 Left 2 !.step param run 1 1000 1
TEXT 296 88 Left 2 !.op
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SHEET 1 1216 680
WIRE 384 -112 368 -112
WIRE 416 -112 384 -112
WIRE 368 -80 368 -112
WIRE 304 -16 224 -16
WIRE 480 -16 432 -16
WIRE 512 -16 480 -16
WIRE 512 16 512 -16
WIRE 112 64 96 64
WIRE 144 64 112 64
WIRE 368 80 368 48
WIRE 96 96 96 64
WIRE 224 96 224 -16
WIRE 512 128 512 96
WIRE 560 128 512 128
WIRE 656 128 640 128
WIRE 512 160 512 128
WIRE 656 176 656 128
WIRE 96 192 96 176
WIRE 384 192 368 192
WIRE 416 192 384 192
WIRE 368 224 368 192
WIRE 224 288 224 176
WIRE 304 288 224 288
WIRE 480 288 432 288
WIRE 512 288 512 240
WIRE 512 288 480 288
WIRE 224 304 224 288
WIRE 368 384 368 352
FLAG 656 176 0
FLAG 368 80 0
FLAG 368 384 0
FLAG 384 192 Vdd
FLAG 384 -112 Vdd
FLAG 96 192 0
FLAG 112 64 Vdd
FLAG 480 -16 outp
FLAG 480 288 outn
FLAG 224 304 0
SYMBOL res 496 0 R0
SYMATTR InstName R1
SYMATTR Value 5k
SYMBOL res 496 144 R0
SYMATTR InstName R2
SYMATTR Value 5k
SYMBOL res 656 112 R90
WINDOW 0 0 56 VBottom 2
WINDOW 3 32 56 VTop 2
SYMATTR InstName R3
SYMATTR Value 100k
SYMBOL voltage 96 80 R0
WINDOW 123 0 0 Left 0
WINDOW 39 0 0 Left 0
SYMATTR InstName V2
SYMATTR Value 9
SYMBOL audio_preamp 368 -16 R0
SYMATTR InstName U1
SYMBOL audio_preamp 368 288 R0
SYMATTR InstName U2
SYMBOL voltage 224 80 R0
WINDOW 123 0 0 Left 0
WINDOW 39 0 0 Left 0
SYMATTR InstName V1
SYMATTR Value ""
TEXT 760 -16 Left 2 !.noise V(outp,outn) V1 dec 100 1 1meg
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SHEET 1 880 680
WIRE 0 80 -32 80
WIRE 16 80 0 80
WIRE 128 80 96 80
WIRE 144 80 128 80
WIRE -32 112 -32 80
WIRE 144 112 144 80
WIRE -32 208 -32 192
WIRE 144 208 144 192
FLAG -32 208 0
FLAG 144 208 0
FLAG 0 80 vin
FLAG 128 80 vout
SYMBOL voltage -32 96 R0
WINDOW 123 0 0 Left 0
WINDOW 39 0 0 Left 0
SYMATTR InstName V1
SYMATTR Value 6
SYMBOL res 112 64 R90
WINDOW 0 0 56 VBottom 2
WINDOW 3 32 56 VTop 2
SYMATTR InstName R1
SYMATTR Value 11k
SYMBOL res 160 208 R180
WINDOW 0 36 76 Left 2
WINDOW 3 36 40 Left 2
SYMATTR InstName R2
SYMATTR Value 1k
TEXT 48 176 Left 2 !.op
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SHEET 1 880 680
WIRE -48 48 -96 48
WIRE -16 48 -48 48
WIRE 80 48 32 48
WIRE 128 48 80 48
WIRE 208 48 128 48
WIRE 304 48 256 48
WIRE 352 48 304 48
WIRE 512 48 448 48
WIRE 560 48 512 48
WIRE -96 64 -96 48
WIRE 32 64 32 48
WIRE 128 64 128 48
WIRE 256 64 256 48
WIRE 352 64 352 48
WIRE 448 64 448 48
WIRE 560 64 560 48
WIRE -16 80 -16 48
WIRE 208 80 208 48
WIRE -96 160 -96 144
WIRE -16 160 -16 128
WIRE 32 160 32 144
WIRE 128 160 128 144
WIRE 208 160 208 128
WIRE 256 160 256 144
WIRE 352 160 352 144
WIRE 448 160 448 144
WIRE 560 160 560 144
FLAG -96 160 0
FLAG 32 160 0
FLAG 128 160 0
FLAG 256 160 0
FLAG 208 160 0
FLAG 352 160 0
FLAG -16 160 0
FLAG 448 160 0
FLAG 560 160 0
FLAG -48 48 node1
FLAG 80 48 node2
FLAG 304 48 node3
FLAG 512 48 node4
SYMBOL voltage -96 48 R0
WINDOW 123 0 0 Left 0
WINDOW 39 0 0 Left 0
SYMATTR InstName V1
SYMATTR Value 1
SYMBOL e 32 48 R0
SYMATTR InstName E1
SYMATTR Value 2
SYMBOL res 112 48 R0
SYMATTR InstName R1
SYMATTR Value 1
SYMBOL f 448 64 R0
SYMATTR InstName F1
SYMATTR Value V1 5
SYMBOL g 256 48 R0
SYMATTR InstName G1
SYMATTR Value 5
SYMBOL h 560 48 R0
SYMATTR InstName H1
SYMATTR Value E1 2
SYMBOL res 336 48 R0
SYMATTR InstName R2
SYMATTR Value 0.1
TEXT -104 208 Left 2 !.op
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SHEET 1 972 680
WIRE 16 96 -48 96
WIRE 80 96 16 96
WIRE -48 112 -48 96
WIRE 80 112 80 96
WIRE -48 208 -48 192
WIRE 80 208 80 192
WIRE 112 256 80 256
WIRE 128 256 112 256
WIRE 80 288 80 256
WIRE 80 384 80 368
FLAG -48 208 0
FLAG 80 208 0
FLAG 16 96 node1
FLAG 80 384 0
FLAG 112 256 node2
SYMBOL voltage -48 96 R0
SYMATTR InstName V1
SYMATTR Value 0
SYMBOL bi 80 112 R0
SYMATTR InstName B1
SYMATTR Value I=(V(node1)>0)*10m*V(node1)**2
SYMBOL bv 80 272 R0
SYMATTR InstName B2
SYMATTR Value V=sin(2*pi*3*V(node1))
TEXT 272 256 Left 2 !.dc V1 -1 1 1m



* This file contains the imput impedance values for a 2.4 GHz band WiFi antenna modeled and simulated with MATLAB Antenna Toolbox
* The antenna was modeled with the following MATLAB code:

* antennaObject = design(reflector('Exciter', dipole), 2450*1e6);
* antennaObject.Exciter.Length = 0.0551;
* antennaObject.Exciter.Width = 0.005;
* antennaObject.Exciter.Conductor.Name = 'Copper';
* antennaObject.Exciter.Conductor.Conductivity = 5.96*1e7;
* antennaObject.Exciter.Conductor.Thickness = 3.556e-05;
* antennaObject.Substrate.Thickness = 0.01;
* antennaObject.GroundPlaneLength = 0.1;
* antennaObject.GroundPlaneWidth = 0.1;
* antennaObject.Spacing = 0.01;
* antennaObject.Conductor.Name = 'Copper';
* antennaObject.Conductor.Conductivity = 5.96*1e7;
* antennaObject.Conductor.Thickness = 3.556e-05;

* freqs = (2000:2.5:2900)*1e6;
* Zs = impedance(antennaObject, freqs);

* The antenna had a gain of 8.6 dBi and a radiation pattern simmilar to a dipole field but with one side suppressed due to the presence of the reflector plane

.subckt Zs 1 2
Rreg 1 2 1G
BI 1 2 I=V(1,2) r_i Freq=
+ (2000000000.000000, 0.000564, 0.011558)
+ (2002500000.000000, 0.000575, 0.011622)
+ (2005000000.000000, 0.000585, 0.011687)
+ (2007500000.000000, 0.000595, 0.011752)
+ (2010000000.000000, 0.000606, 0.011819)
+ (2012500000.000000, 0.000617, 0.011886)
+ (2015000000.000000, 0.000628, 0.011953)
+ (2017500000.000000, 0.000639, 0.012022)
+ (2020000000.000000, 0.000651, 0.012091)
+ (2022500000.000000, 0.000663, 0.012161)
+ (2025000000.000000, 0.000675, 0.012231)
+ (2027500000.000000, 0.000687, 0.012303)
+ (2030000000.000000, 0.000700, 0.012375)
+ (2032500000.000000, 0.000713, 0.012448)
+ (2035000000.000000, 0.000726, 0.012522)
+ (2037500000.000000, 0.000740, 0.012597)
+ (2040000000.000000, 0.000753, 0.012672)
+ (2042500000.000000, 0.000768, 0.012749)
+ (2045000000.000000, 0.000782, 0.012826)
+ (2047500000.000000, 0.000797, 0.012905)
+ (2050000000.000000, 0.000812, 0.012984)
+ (2052500000.000000, 0.000827, 0.013064)
+ (2055000000.000000, 0.000843, 0.013145)
+ (2057500000.000000, 0.000859, 0.013227)
+ (2060000000.000000, 0.000875, 0.013310)
+ (2062500000.000000, 0.000892, 0.013394)
+ (2065000000.000000, 0.000910, 0.013479)
+ (2067500000.000000, 0.000927, 0.013565)
+ (2070000000.000000, 0.000945, 0.013652)
+ (2072500000.000000, 0.000964, 0.013740)
+ (2075000000.000000, 0.000983, 0.013830)
+ (2077500000.000000, 0.001002, 0.013920)
+ (2080000000.000000, 0.001022, 0.014012)
+ (2082500000.000000, 0.001042, 0.014104)
+ (2085000000.000000, 0.001063, 0.014198)
+ (2087500000.000000, 0.001084, 0.014293)
+ (2090000000.000000, 0.001106, 0.014390)
+ (2092500000.000000, 0.001128, 0.014487)
+ (2095000000.000000, 0.001151, 0.014586)
+ (2097500000.000000, 0.001174, 0.014686)
+ (2100000000.000000, 0.001198, 0.014788)
+ (2102500000.000000, 0.001223, 0.014891)
+ (2105000000.000000, 0.001248, 0.014995)
+ (2107500000.000000, 0.001274, 0.015100)
+ (2110000000.000000, 0.001300, 0.015207)
+ (2112500000.000000, 0.001328, 0.015316)
+ (2115000000.000000, 0.001355, 0.015426)
+ (2117500000.000000, 0.001384, 0.015538)
+ (2120000000.000000, 0.001413, 0.015651)
+ (2122500000.000000, 0.001443, 0.015765)
+ (2125000000.000000, 0.001474, 0.015882)
+ (2127500000.000000, 0.001506, 0.016000)
+ (2130000000.000000, 0.001539, 0.016119)
+ (2132500000.000000, 0.001572, 0.016241)
+ (2135000000.000000, 0.001606, 0.016364)
+ (2137500000.000000, 0.001641, 0.016489)
+ (2140000000.000000, 0.001678, 0.016616)
+ (2142500000.000000, 0.001715, 0.016745)
+ (2145000000.000000, 0.001753, 0.016875)
+ (2147500000.000000, 0.001792, 0.017008)
+ (2150000000.000000, 0.001833, 0.017142)
+ (2152500000.000000, 0.001874, 0.017279)
+ (2155000000.000000, 0.001917, 0.017418)
+ (2157500000.000000, 0.001961, 0.017559)
+ (2160000000.000000, 0.002006, 0.017702)
+ (2162500000.000000, 0.002052, 0.017847)
+ (2165000000.000000, 0.002100, 0.017995)
+ (2167500000.000000, 0.002149, 0.018145)
+ (2170000000.000000, 0.002200, 0.018297)
+ (2172500000.000000, 0.002252, 0.018452)
+ (2175000000.000000, 0.002305, 0.018609)
+ (2177500000.000000, 0.002361, 0.018769)
+ (2180000000.000000, 0.002418, 0.018932)
+ (2182500000.000000, 0.002476, 0.019097)
+ (2185000000.000000, 0.002537, 0.019265)
+ (2187500000.000000, 0.002599, 0.019436)
+ (2190000000.000000, 0.002664, 0.019609)
+ (2192500000.000000, 0.002730, 0.019786)
+ (2195000000.000000, 0.002798, 0.019966)
+ (2197500000.000000, 0.002869, 0.020149)
+ (2200000000.000000, 0.002942, 0.020334)
+ (2202500000.000000, 0.003017, 0.020524)
+ (2205000000.000000, 0.003095, 0.020716)
+ (2207500000.000000, 0.003175, 0.020912)
+ (2210000000.000000, 0.003258, 0.021111)
+ (2212500000.000000, 0.003344, 0.021314)
+ (2215000000.000000, 0.003432, 0.021521)
+ (2217500000.000000, 0.003524, 0.021732)
+ (2220000000.000000, 0.003619, 0.021946)
+ (2222500000.000000, 0.003717, 0.022164)
+ (2225000000.000000, 0.003818, 0.022386)
+ (2227500000.000000, 0.003923, 0.022613)
+ (2230000000.000000, 0.004032, 0.022843)
+ (2232500000.000000, 0.004145, 0.023078)
+ (2235000000.000000, 0.004262, 0.023318)
+ (2237500000.000000, 0.004383, 0.023562)
+ (2240000000.000000, 0.004508, 0.023810)
+ (2242500000.000000, 0.004638, 0.024064)
+ (2245000000.000000, 0.004773, 0.024322)
+ (2247500000.000000, 0.004913, 0.024585)
+ (2250000000.000000, 0.005059, 0.024854)
+ (2252500000.000000, 0.005210, 0.025128)
+ (2255000000.000000, 0.005366, 0.025407)
+ (2257500000.000000, 0.005529, 0.025692)
+ (2260000000.000000, 0.005699, 0.025982)
+ (2262500000.000000, 0.005875, 0.026278)
+ (2265000000.000000, 0.006058, 0.026580)
+ (2267500000.000000, 0.006249, 0.026888)
+ (2270000000.000000, 0.006447, 0.027203)
+ (2272500000.000000, 0.006654, 0.027523)
+ (2275000000.000000, 0.006869, 0.027850)
+ (2277500000.000000, 0.007093, 0.028184)
+ (2280000000.000000, 0.007327, 0.028524)
+ (2282500000.000000, 0.007571, 0.028871)
+ (2285000000.000000, 0.007826, 0.029225)
+ (2287500000.000000, 0.008092, 0.029586)
+ (2290000000.000000, 0.008369, 0.029955)
+ (2292500000.000000, 0.008659, 0.030330)
+ (2295000000.000000, 0.008962, 0.030713)
+ (2297500000.000000, 0.009279, 0.031103)
+ (2300000000.000000, 0.009610, 0.031501)
+ (2302500000.000000, 0.009957, 0.031907)
+ (2305000000.000000, 0.010320, 0.032320)
+ (2307500000.000000, 0.010700, 0.032740)
+ (2310000000.000000, 0.011099, 0.033168)
+ (2312500000.000000, 0.011516, 0.033604)
+ (2315000000.000000, 0.011954, 0.034047)
+ (2317500000.000000, 0.012413, 0.034497)
+ (2320000000.000000, 0.012895, 0.034954)
+ (2322500000.000000, 0.013402, 0.035418)
+ (2325000000.000000, 0.013933, 0.035889)
+ (2327500000.000000, 0.014492, 0.036366)
+ (2330000000.000000, 0.015079, 0.036849)
+ (2332500000.000000, 0.015696, 0.037337)
+ (2335000000.000000, 0.016345, 0.037829)
+ (2337500000.000000, 0.017029, 0.038325)
+ (2340000000.000000, 0.017748, 0.038824)
+ (2342500000.000000, 0.018505, 0.039325)
+ (2345000000.000000, 0.019302, 0.039826)
+ (2347500000.000000, 0.020141, 0.040326)
+ (2350000000.000000, 0.021026, 0.040823)
+ (2352500000.000000, 0.021957, 0.041316)
+ (2355000000.000000, 0.022939, 0.041802)
+ (2357500000.000000, 0.023973, 0.042278)
+ (2360000000.000000, 0.025062, 0.042742)
+ (2362500000.000000, 0.026209, 0.043190)
+ (2365000000.000000, 0.027416, 0.043619)
+ (2367500000.000000, 0.028687, 0.044024)
+ (2370000000.000000, 0.030023, 0.044400)
+ (2372500000.000000, 0.031428, 0.044743)
+ (2375000000.000000, 0.032903, 0.045045)
+ (2377500000.000000, 0.034451, 0.045300)
+ (2380000000.000000, 0.036073, 0.045502)
+ (2382500000.000000, 0.037770, 0.045641)
+ (2385000000.000000, 0.039542, 0.045709)
+ (2387500000.000000, 0.041389, 0.045696)
+ (2390000000.000000, 0.043310, 0.045592)
+ (2392500000.000000, 0.045301, 0.045386)
+ (2395000000.000000, 0.047360, 0.045066)
+ (2397500000.000000, 0.049480, 0.044620)
+ (2400000000.000000, 0.051654, 0.044036)
+ (2402500000.000000, 0.053873, 0.043300)
+ (2405000000.000000, 0.056124, 0.042402)
+ (2407500000.000000, 0.058395, 0.041329)
+ (2410000000.000000, 0.060669, 0.040071)
+ (2412500000.000000, 0.062927, 0.038620)
+ (2415000000.000000, 0.065147, 0.036968)
+ (2417500000.000000, 0.067308, 0.035112)
+ (2420000000.000000, 0.069383, 0.033050)
+ (2422500000.000000, 0.071347, 0.030787)
+ (2425000000.000000, 0.073173, 0.028328)
+ (2427500000.000000, 0.074834, 0.025686)
+ (2430000000.000000, 0.076306, 0.022876)
+ (2432500000.000000, 0.077566, 0.019920)
+ (2435000000.000000, 0.078593, 0.016841)
+ (2437500000.000000, 0.079371, 0.013667)
+ (2440000000.000000, 0.079888, 0.010430)
+ (2442500000.000000, 0.080138, 0.007161)
+ (2445000000.000000, 0.080120, 0.003894)
+ (2447500000.000000, 0.079838, 0.000661)
+ (2450000000.000000, 0.079301, -0.002508)
+ (2452500000.000000, 0.078523, -0.005582)
+ (2455000000.000000, 0.077522, -0.008539)
+ (2457500000.000000, 0.076318, -0.011354)
+ (2460000000.000000, 0.074935, -0.014013)
+ (2462500000.000000, 0.073397, -0.016500)
+ (2465000000.000000, 0.071727, -0.018808)
+ (2467500000.000000, 0.069952, -0.020930)
+ (2470000000.000000, 0.068094, -0.022867)
+ (2472500000.000000, 0.066176, -0.024618)
+ (2475000000.000000, 0.064217, -0.026189)
+ (2477500000.000000, 0.062236, -0.027586)
+ (2480000000.000000, 0.060250, -0.028817)
+ (2482500000.000000, 0.058272, -0.029890)
+ (2485000000.000000, 0.056314, -0.030816)
+ (2487500000.000000, 0.054387, -0.031606)
+ (2490000000.000000, 0.052498, -0.032269)
+ (2492500000.000000, 0.050655, -0.032816)
+ (2495000000.000000, 0.048862, -0.033257)
+ (2497500000.000000, 0.047123, -0.033602)
+ (2500000000.000000, 0.045441, -0.033860)
+ (2502500000.000000, 0.043818, -0.034040)
+ (2505000000.000000, 0.042254, -0.034151)
+ (2507500000.000000, 0.040749, -0.034199)
+ (2510000000.000000, 0.039304, -0.034192)
+ (2512500000.000000, 0.037918, -0.034136)
+ (2515000000.000000, 0.036589, -0.034037)
+ (2517500000.000000, 0.035316, -0.033900)
+ (2520000000.000000, 0.034097, -0.033730)
+ (2522500000.000000, 0.032931, -0.033531)
+ (2525000000.000000, 0.031816, -0.033307)
+ (2527500000.000000, 0.030750, -0.033062)
+ (2530000000.000000, 0.029730, -0.032799)
+ (2532500000.000000, 0.028755, -0.032520)
+ (2535000000.000000, 0.027824, -0.032228)
+ (2537500000.000000, 0.026933, -0.031925)
+ (2540000000.000000, 0.026082, -0.031614)
+ (2542500000.000000, 0.025268, -0.031295)
+ (2545000000.000000, 0.024489, -0.030971)
+ (2547500000.000000, 0.023744, -0.030642)
+ (2550000000.000000, 0.023032, -0.030310)
+ (2552500000.000000, 0.022350, -0.029977)
+ (2555000000.000000, 0.021697, -0.029642)
+ (2557500000.000000, 0.021072, -0.029307)
+ (2560000000.000000, 0.020473, -0.028973)
+ (2562500000.000000, 0.019899, -0.028639)
+ (2565000000.000000, 0.019349, -0.028308)
+ (2567500000.000000, 0.018822, -0.027978)
+ (2570000000.000000, 0.018316, -0.027651)
+ (2572500000.000000, 0.017830, -0.027327)
+ (2575000000.000000, 0.017364, -0.027006)
+ (2577500000.000000, 0.016916, -0.026688)
+ (2580000000.000000, 0.016486, -0.026374)
+ (2582500000.000000, 0.016073, -0.026063)
+ (2585000000.000000, 0.015675, -0.025757)
+ (2587500000.000000, 0.015293, -0.025454)
+ (2590000000.000000, 0.014925, -0.025156)
+ (2592500000.000000, 0.014571, -0.024862)
+ (2595000000.000000, 0.014230, -0.024572)
+ (2597500000.000000, 0.013901, -0.024286)
+ (2600000000.000000, 0.013584, -0.024005)
+ (2602500000.000000, 0.013279, -0.023728)
+ (2605000000.000000, 0.012985, -0.023455)
+ (2607500000.000000, 0.012701, -0.023187)
+ (2610000000.000000, 0.012427, -0.022923)
+ (2612500000.000000, 0.012162, -0.022663)
+ (2615000000.000000, 0.011906, -0.022407)
+ (2617500000.000000, 0.011659, -0.022155)
+ (2620000000.000000, 0.011421, -0.021908)
+ (2622500000.000000, 0.011190, -0.021665)
+ (2625000000.000000, 0.010966, -0.021425)
+ (2627500000.000000, 0.010750, -0.021190)
+ (2630000000.000000, 0.010541, -0.020958)
+ (2632500000.000000, 0.010339, -0.020730)
+ (2635000000.000000, 0.010143, -0.020506)
+ (2637500000.000000, 0.009953, -0.020286)
+ (2640000000.000000, 0.009769, -0.020070)
+ (2642500000.000000, 0.009591, -0.019857)
+ (2645000000.000000, 0.009418, -0.019647)
+ (2647500000.000000, 0.009250, -0.019441)
+ (2650000000.000000, 0.009087, -0.019238)
+ (2652500000.000000, 0.008929, -0.019039)
+ (2655000000.000000, 0.008776, -0.018843)
+ (2657500000.000000, 0.008627, -0.018650)
+ (2660000000.000000, 0.008482, -0.018460)
+ (2662500000.000000, 0.008342, -0.018274)
+ (2665000000.000000, 0.008205, -0.018090)
+ (2667500000.000000, 0.008072, -0.017909)
+ (2670000000.000000, 0.007943, -0.017731)
+ (2672500000.000000, 0.007817, -0.017557)
+ (2675000000.000000, 0.007695, -0.017384)
+ (2677500000.000000, 0.007576, -0.017215)
+ (2680000000.000000, 0.007461, -0.017048)
+ (2682500000.000000, 0.007348, -0.016884)
+ (2685000000.000000, 0.007238, -0.016722)
+ (2687500000.000000, 0.007131, -0.016563)
+ (2690000000.000000, 0.007027, -0.016406)
+ (2692500000.000000, 0.006926, -0.016252)
+ (2695000000.000000, 0.006827, -0.016100)
+ (2697500000.000000, 0.006730, -0.015951)
+ (2700000000.000000, 0.006636, -0.015803)
+ (2702500000.000000, 0.006544, -0.015658)
+ (2705000000.000000, 0.006455, -0.015515)
+ (2707500000.000000, 0.006367, -0.015375)
+ (2710000000.000000, 0.006282, -0.015236)
+ (2712500000.000000, 0.006199, -0.015099)
+ (2715000000.000000, 0.006118, -0.014964)
+ (2717500000.000000, 0.006038, -0.014832)
+ (2720000000.000000, 0.005961, -0.014701)
+ (2722500000.000000, 0.005885, -0.014572)
+ (2725000000.000000, 0.005811, -0.014445)
+ (2727500000.000000, 0.005739, -0.014320)
+ (2730000000.000000, 0.005668, -0.014196)
+ (2732500000.000000, 0.005599, -0.014074)
+ (2735000000.000000, 0.005532, -0.013954)
+ (2737500000.000000, 0.005466, -0.013836)
+ (2740000000.000000, 0.005401, -0.013719)
+ (2742500000.000000, 0.005338, -0.013604)
+ (2745000000.000000, 0.005276, -0.013490)
+ (2747500000.000000, 0.005215, -0.013378)
+ (2750000000.000000, 0.005156, -0.013268)
+ (2752500000.000000, 0.005098, -0.013159)
+ (2755000000.000000, 0.005041, -0.013051)
+ (2757500000.000000, 0.004986, -0.012945)
+ (2760000000.000000, 0.004931, -0.012840)
+ (2762500000.000000, 0.004878, -0.012737)
+ (2765000000.000000, 0.004826, -0.012635)
+ (2767500000.000000, 0.004774, -0.012534)
+ (2770000000.000000, 0.004724, -0.012434)
+ (2772500000.000000, 0.004675, -0.012336)
+ (2775000000.000000, 0.004627, -0.012239)
+ (2777500000.000000, 0.004580, -0.012144)
+ (2780000000.000000, 0.004533, -0.012049)
+ (2782500000.000000, 0.004488, -0.011956)
+ (2785000000.000000, 0.004443, -0.011864)
+ (2787500000.000000, 0.004399, -0.011773)
+ (2790000000.000000, 0.004356, -0.011683)
+ (2792500000.000000, 0.004314, -0.011594)
+ (2795000000.000000, 0.004273, -0.011506)
+ (2797500000.000000, 0.004232, -0.011419)
+ (2800000000.000000, 0.004193, -0.011334)
+ (2802500000.000000, 0.004154, -0.011249)
+ (2805000000.000000, 0.004115, -0.011166)
+ (2807500000.000000, 0.004077, -0.011083)
+ (2810000000.000000, 0.004040, -0.011001)
+ (2812500000.000000, 0.004004, -0.010921)
+ (2815000000.000000, 0.003968, -0.010841)
+ (2817500000.000000, 0.003933, -0.010762)
+ (2820000000.000000, 0.003899, -0.010684)
+ (2822500000.000000, 0.003865, -0.010607)
+ (2825000000.000000, 0.003832, -0.010531)
+ (2827500000.000000, 0.003799, -0.010456)
+ (2830000000.000000, 0.003767, -0.010381)
+ (2832500000.000000, 0.003735, -0.010308)
+ (2835000000.000000, 0.003704, -0.010235)
+ (2837500000.000000, 0.003674, -0.010163)
+ (2840000000.000000, 0.003644, -0.010092)
+ (2842500000.000000, 0.003614, -0.010021)
+ (2845000000.000000, 0.003585, -0.009951)
+ (2847500000.000000, 0.003557, -0.009882)
+ (2850000000.000000, 0.003528, -0.009814)
+ (2852500000.000000, 0.003501, -0.009747)
+ (2855000000.000000, 0.003474, -0.009680)
+ (2857500000.000000, 0.003447, -0.009614)
+ (2860000000.000000, 0.003420, -0.009549)
+ (2862500000.000000, 0.003395, -0.009484)
+ (2865000000.000000, 0.003369, -0.009420)
+ (2867500000.000000, 0.003344, -0.009357)
+ (2870000000.000000, 0.003319, -0.009294)
+ (2872500000.000000, 0.003295, -0.009232)
+ (2875000000.000000, 0.003271, -0.009171)
+ (2877500000.000000, 0.003247, -0.009110)
+ (2880000000.000000, 0.003224, -0.009050)
+ (2882500000.000000, 0.003201, -0.008990)
+ (2885000000.000000, 0.003178, -0.008931)
+ (2887500000.000000, 0.003156, -0.008873)
+ (2890000000.000000, 0.003134, -0.008815)
+ (2892500000.000000, 0.003113, -0.008758)
+ (2895000000.000000, 0.003092, -0.008701)
+ (2897500000.000000, 0.003071, -0.008645)
+ (2900000000.000000, 0.003050, -0.008589)
.ends Zs


Version 4

SymbolType CELL

LINE Normal 0 -48 0 -32

LINE Normal 0 48 0 32

RECTANGLE Normal 24 32 -24 -32

TEXT 0 0 Center 2 Z(f)

WINDOW 0 30 -25 Left 2

SYMATTR Prefix X

SYMATTR SpiceModel Zs

SYMATTR Description Arbitrary impedance model

PIN 0 -48 NONE 8

PINATTR PinName 1

PINATTR SpiceOrder 1

PIN 0 48 NONE 8

PINATTR PinName 2

PINATTR SpiceOrder 2




Version 4
SHEET 1 1972 692
WIRE 176 96 -336 96
WIRE 464 96 304 96
WIRE 576 96 544 96
WIRE 608 96 576 96
WIRE 800 96 688 96
WIRE -336 112 -336 96
WIRE 176 112 176 96
WIRE 304 112 304 96
WIRE 800 112 800 96
WIRE 576 128 576 96
WIRE -336 224 -336 192
WIRE 176 224 176 208
WIRE 304 224 304 192
WIRE 576 224 576 192
WIRE 800 224 800 208
WIRE -272 432 -336 432
WIRE -192 432 -272 432
WIRE -64 432 -112 432
WIRE -16 432 -64 432
WIRE 128 432 64 432
WIRE 176 432 128 432
WIRE 368 432 304 432
WIRE 448 432 368 432
WIRE 576 432 512 432
WIRE 640 432 576 432
WIRE 768 432 704 432
WIRE 816 432 768 432
WIRE -336 464 -336 432
WIRE -64 464 -64 432
WIRE 176 464 176 432
WIRE 304 464 304 432
WIRE 576 464 576 432
WIRE -336 560 -336 544
WIRE -64 560 -64 544
WIRE 176 560 176 544
WIRE 304 560 304 544
WIRE 576 560 576 544
FLAG 176 224 0
FLAG -336 224 0
FLAG 800 224 0
FLAG 304 224 0
FLAG -336 560 0
FLAG -64 560 0
FLAG 176 560 0
FLAG -272 432 port1
FLAG 128 432 port2
FLAG 576 224 0
FLAG 176 96 unmatched
FLAG 800 96 matched
FLAG 304 560 0
FLAG 576 560 0
FLAG 368 432 in
FLAG 768 432 out
SYMBOL voltage -336 96 R0
WINDOW 123 24 88 Left 2
WINDOW 39 24 112 Left 2
SYMATTR Value2 AC 1
SYMATTR SpiceLine Rser=50
SYMATTR InstName V1
SYMATTR Value ""
SYMBOL voltage -336 448 R0
WINDOW 123 24 124 Left 2
WINDOW 39 24 152 Left 2
SYMATTR Value2 AC 2
SYMATTR SpiceLine Rser=50
SYMATTR InstName V3
SYMATTR Value ""
SYMBOL res -96 416 R90
WINDOW 0 0 56 VBottom 2
WINDOW 3 32 56 VTop 2
SYMATTR InstName R1
SYMATTR Value 18
SYMBOL res -48 560 R180
WINDOW 0 36 76 Left 2
WINDOW 3 36 40 Left 2
SYMATTR InstName R2
SYMATTR Value 43
SYMBOL res -32 448 R270
WINDOW 0 32 56 VTop 2
WINDOW 3 0 56 VBottom 2
SYMATTR InstName R3
SYMATTR Value 49
SYMBOL res 160 448 R0
SYMATTR InstName R4
SYMATTR Value 75
SYMBOL ind 592 112 R270
WINDOW 0 32 56 VTop 2
WINDOW 3 5 56 VBottom 2
SYMATTR InstName L1
SYMATTR Value 1.6n
SYMBOL ind 448 112 R270
WINDOW 0 32 56 VTop 2
WINDOW 3 5 56 VBottom 2
SYMATTR InstName L2
SYMATTR Value 1.5n
SYMBOL cap 560 128 R0
SYMATTR InstName C1
SYMATTR Value 2.6p
SYMBOL voltage 304 96 R0
WINDOW 123 24 88 Left 2
WINDOW 39 24 112 Left 2
SYMATTR Value2 AC 1
SYMATTR SpiceLine Rser=50
SYMATTR InstName V2
SYMATTR Value ""
SYMBOL voltage 304 448 R0
WINDOW 123 24 124 Left 2
WINDOW 39 24 152 Left 2
SYMATTR Value2 AC 2
SYMATTR InstName V4
SYMATTR Value ""
SYMBOL cap 512 416 R90
WINDOW 0 0 32 VBottom 2
WINDOW 3 32 32 VTop 2
SYMATTR InstName C2
SYMATTR Value 1.5p
SYMBOL cap 704 416 R90
WINDOW 0 0 32 VBottom 2
WINDOW 3 32 32 VTop 2
SYMATTR InstName C3
SYMATTR Value 2p
SYMBOL ind 560 448 R0
SYMATTR InstName L3
SYMATTR Value 4.4n
SYMBOL ArbitraryImpedance 176 160 R0
SYMATTR InstName U1
SYMBOL ArbitraryImpedance 800 160 R0
SYMATTR InstName U2
TEXT 928 128 Left 2 !.ac lin 1000 2.0G 2.9G
TEXT -160 280 Left 2 !.net V1 Rin = 50
TEXT 928 104 Left 2 !.include antennaImpedance.sub
TEXT 480 280 Left 2 !.net V2 Rin = 50
TEXT 480 24 Left 2 ;Matching network
TEXT -160 368 Left 2 ;Matching network
TEXT -144 616 Left 2 !.net I(R4) V3
TEXT 480 368 Left 2 ;Matching network
TEXT 416 616 Left 2 !.net V(out) V4 Rin = 50 Rout = 75
RECTANGLE Normal 720 256 432 48 1
RECTANGLE Normal 80 592 -208 384 1
RECTANGLE Normal 720 592 432 384 1



.MODEL Dinc D(IS=10.4n RS=51.5m BV=75.0 IBV=1.00u
+ CJO=2.00p  M=0.333 N=2.07 TT=5.76n)



Version 4
SHEET 1 1096 680
WIRE 416 -48 336 -48
WIRE 544 -48 480 -48
WIRE 592 -48 544 -48
WIRE 640 -48 592 -48
WIRE 336 -16 336 -48
WIRE 544 -16 544 -48
WIRE 640 -16 640 -48
WIRE 336 80 336 64
WIRE 544 80 544 48
WIRE 640 80 640 64
WIRE 416 208 336 208
WIRE 544 208 480 208
WIRE 592 208 544 208
WIRE 640 208 592 208
WIRE 336 240 336 208
WIRE 544 240 544 208
WIRE 640 240 640 208
WIRE 336 336 336 320
WIRE 544 336 544 304
WIRE 640 336 640 320
FLAG 336 80 0
FLAG 544 80 0
FLAG 640 80 0
FLAG 336 336 0
FLAG 544 336 0
FLAG 640 336 0
FLAG 592 -48 node1
FLAG 592 208 node2
SYMBOL voltage 336 -32 R0
WINDOW 123 0 0 Left 0
WINDOW 39 0 0 Left 0
SYMATTR InstName V1
SYMATTR Value SINE(0 10 1k)
SYMBOL diode 416 -32 R270
WINDOW 0 32 32 VTop 2
WINDOW 3 0 32 VBottom 2
SYMATTR InstName D1
SYMATTR Value Dtext
SYMBOL cap 528 -16 R0
SYMATTR InstName C1
SYMATTR Value 100µ
SYMBOL res 624 -32 R0
SYMATTR InstName R1
SYMATTR Value 100
SYMBOL voltage 336 224 R0
SYMATTR InstName V2
SYMATTR Value SINE(0 10 1k)
SYMBOL diode 416 224 R270
WINDOW 0 32 32 VTop 2
WINDOW 3 0 32 VBottom 2
SYMATTR InstName D2
SYMATTR Value Dinc
SYMBOL cap 528 240 R0
SYMATTR InstName C2
SYMATTR Value 100µ
SYMBOL res 624 224 R0
SYMATTR InstName R2
SYMATTR Value 50
TEXT 280 120 Left 2 !.MODEL Dtext D(IS=10.4n RS=51.5m BV=75.0 IBV=1.00u\n+ CJO=2.00p  M=0.333 N=2.07 TT=5.76n)
TEXT 368 400 Left 2 !.include Dinc.sub
TEXT 744 224 Left 2 !.tran 0 3m 0 10u
TEXT 744 256 Left 2 !.ic V(node1) = 0
TEXT 744 288 Left 2 !.ic V(node2) = 0
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SHEET 1 888 680
WIRE -112 48 -160 48
WIRE -64 48 -112 48
WIRE 96 48 16 48
WIRE 128 48 96 48
WIRE 224 48 128 48
WIRE 240 48 224 48
WIRE 416 48 320 48
WIRE 464 48 416 48
WIRE 576 48 464 48
WIRE 720 48 656 48
WIRE -160 96 -160 48
WIRE 16 96 16 48
WIRE 128 96 128 48
WIRE 224 96 224 48
WIRE 416 96 416 48
WIRE -208 112 -224 112
WIRE -64 112 -64 48
WIRE -32 112 -64 112
WIRE -208 160 -224 160
WIRE -32 160 -64 160
WIRE -224 224 -224 160
WIRE -160 224 -160 176
WIRE -160 224 -224 224
WIRE -64 224 -64 160
WIRE -64 224 -160 224
WIRE 16 224 16 176
WIRE 128 224 128 160
WIRE 128 224 16 224
WIRE 224 224 224 176
WIRE 224 224 128 224
WIRE 416 224 416 176
WIRE 416 224 224 224
WIRE 720 224 416 224
WIRE -160 240 -160 224
WIRE -304 352 -352 352
WIRE -352 384 -352 352
WIRE -352 480 -352 464
FLAG 720 224 N
IOPIN 720 224 BiDir
FLAG 720 48 P
IOPIN 720 48 BiDir
FLAG 96 48 Cell_inner
FLAG 464 48 U_cell
FLAG -224 112 illumination
IOPIN -224 112 In
FLAG -112 48 Pin
FLAG -304 352 Pdiss
IOPIN -304 352 Out
FLAG -160 240 0
FLAG -352 480 0
SYMBOL diode 112 96 R0
SYMATTR InstName Diode
SYMATTR Value Dsc
SYMBOL res 208 80 R0
SYMATTR InstName Rshunt
SYMATTR Value {Rp}
SYMBOL res 336 32 R90
WINDOW 0 0 56 VBottom 2
WINDOW 3 32 56 VTop 2
SYMATTR InstName Rseries
SYMATTR Value {Rs}
SYMBOL e -160 80 R0
WINDOW 3 9 99 Left 2
SYMATTR Value {w*l}
SYMATTR InstName E1
SYMBOL g 16 80 R0
WINDOW 3 8 96 Left 2
SYMATTR Value {alpha}
SYMATTR InstName G1
SYMBOL bi 416 96 R0
SYMATTR InstName B1
SYMATTR Value I={mp-1}*I(Rseries)
SYMBOL bv 672 48 R90
WINDOW 0 -32 56 VBottom 2
WINDOW 3 32 56 VTop 2
SYMATTR InstName B2
SYMATTR Value V={ms-1}*V(U_cell,N)
SYMBOL bi2 -352 384 R0
SYMATTR InstName B3
SYMATTR Value I={mp*ms}*V(Pin)+V(P,N)*I(B2)
TEXT 112 336 Left 2 !.model Dsc D(Is = {Is} N = {n} BV = {bdV} Ibv = {bdI})
TEXT -400 -40 Left 2 ;Optikai modell
TEXT -16 -40 Left 2 ;Fotovoltaikus cella modellje
TEXT 368 -40 Left 2 ;Soros és párhuzamos cellák
TEXT -400 296 Left 2 ;Teljesítmény disszipáció (áramjel)
RECTANGLE Normal -48 272 -400 -16 3
RECTANGLE Normal 352 272 -16 -16 3
RECTANGLE Normal 784 272 368 -16 3
RECTANGLE Normal 96 512 -400 320 3



* Solar cell model for SPICE simulations
* Developed by David Deak for educational use only, commercial use is not authorized
* Developed for practice course in Green Electricity Production (BMEVIEEMA11)
* January 2024

.subckt cell1 1 2 3 4
X1 1 2 3 4 SolarCell w={w} l={l} ms={ms} mp={mp} alpha=0.3 Is=1e-9 n=1 bdV=10 bdI=1 Rs=1m Rp=1k
.ends

.subckt SolarCell P N Illumination Pdiss
* optical model
E1 Pin 0 illumination 0 {w*l}
* solar cell one diode model
G1 N Cell_inner Pin 0 {alpha}
D1 Cell_inner N Dsc
.model Dsc D(Is = {Is} N = {n} BV = {bdV} Ibv = {bdI})
Rshunt Cell_inner N {Rp}
Rseries U_cell Cell_inner {Rs}
* series and parallel multipliers
B1 U_cell N I={mp-1}*I(Rseries)
B2 P U_cell V={ms-1}*V(U_cell,N)
* power dissipation
B3 0 Pdiss I={mp*ms}*V(Pin)+V(P,N)*I(B2)
.ends
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SymbolType CELL

LINE Normal -36 -48 -59 48

LINE Normal 60 -48 -36 -48

LINE Normal 37 48 60 -48

LINE Normal -59 48 37 48

LINE Normal 0 -80 0 -48

LINE Normal 0 80 0 48

LINE Normal -20 -48 -43 48

LINE Normal -4 -48 -27 48

LINE Normal 12 -48 -11 48

LINE Normal 28 -48 5 48

LINE Normal 44 -48 21 48

LINE Normal -55 32 41 32

LINE Normal -52 16 44 16

LINE Normal -48 0 48 0

LINE Normal -43 -16 53 -16

LINE Normal -40 -32 56 -32

LINE Normal -63 41 -91 -24

LINE Normal -42 -48 -80 -48

LINE Normal -56 15 -80 -21

LINE Normal -45 -36 -70 -39

LINE Normal -51 -13 -71 -28

LINE Normal -112 -32 -96 -32

LINE Normal 91 -16 81 -18

LINE Normal 86 -6 91 -16

LINE Normal 112 -16 96 -16

CIRCLE Normal -69 -21 -96 -48

ARC Normal 54 -3 74 -18 74 -18 54 -14

ARC Normal 54 2 74 -13 74 -13 54 -9

ARC Normal 88 -21 70 -7 70 -7 88 -10

ARC Normal 88 -26 70 -12 70 -12 88 -15

WINDOW 0 16 -64 Left 2

WINDOW 3 48 32 Left 0

WINDOW 123 48 42 Left 0

SYMATTR Value w=15.6 l=15.6

SYMATTR Value2 ms=1 mp=1

SYMATTR ModelFile solar_cell.sub

PIN 0 -80 RIGHT 8

PINATTR PinName +

PINATTR SpiceOrder 1

PIN 0 80 RIGHT 8

PINATTR PinName -

PINATTR SpiceOrder 2

PIN -112 -32 NONE 8

PINATTR PinName illumination

PINATTR SpiceOrder 3

PIN 112 -16 NONE 8

PINATTR PinName Pdiss

PINATTR SpiceOrder 4



